ADS FlowAlert
Installation, Operation, and
Maintenance Manual
November 2010

1300 Meridian Street, Suite 3000
Huntsville, Alabama 35801
(256) 430-3366
www.adsenv.com

QR 775011 A2

ii

ADS FlowAlert Manual

 2010 ADS LLC. All rights reserved.
ADS , ADS Environmental Services, Profile, IntelliServe,
and Accusonic are registered trademarks of ADS LLC.
Enfora™ is a trademark of Enfora, Incorporated.
FlowAlert is a trademark of ADS LLC.
Microsoft and Windows are registered trademarks of Microsoft
Corporation.
All other brand and product names are trademarks or registered
trademarks of their respective holders.
Notice of Proprietary Information
The information contained herein represents the latest information
available at the time of publication. ADS LLC reserves the right to
make any changes or modifications to the content of this document,
without notice, to reflect the latest changes to the equipment. No
part of this document may be reproduced in any form without the
written consent of ADS LLC.

Table of Contents

iii

Table of Contents
Chapter 1 Introduction

1-1

Warnings and FCC Compliance ..................................... 1-2
Communications Disclaimer ................................... 1-2
FCC Part 68 Compliance
(applies only to Landline Units) ...................... 1-3
FCC Part 15 Compliance ........................................ 1-3
GSM/GPRS Modem Information ............................ 1-4
Installation and Configuration ........................................ 1-5
Product Warranty ........................................................... 1-6
New Product Warranty............................................ 1-6
Out-of-Warranty Product Repairs ........................... 1-6
Troubleshooting Fee ............................................... 1-7
Shipping .................................................................. 1-7

Chapter 2 System Overview

2-1

ADS FlowAlert Monitor................................................. 2-4
Printed Circuit Board .............................................. 2-4
Communications...................................................... 2-6
Connectors .............................................................. 2-7
Power ...................................................................... 2-8
Flow Depth Devices ....................................................... 2-9
Pressure Depth Sensor............................................. 2-9
Float Switch .......................................................... 2-10

Chapter 3 Pressure Depth Sensor and
Float Switch Installation 3-1
Investigating Site Characteristics ................................... 3-4
Installing the Sensor in the Pipe ..................................... 3-6
Standard Installation................................................ 3-6
Special Installations .............................................. 3-20
Installing the Sensor in the Manhole or Pump Station
Wet Well ........................................................ 3-31
Securing the Sensor Cable in the Pipe and Manhole .... 3-36

iv

ADS FlowAlert Manual
Installing the Float Switch in the Manhole ................... 3-38
Gathering Parts and Supplies ................................ 3-39
Gathering Tools and Equipment............................ 3-39
Mounting the Float Switch .................................... 3-40
Connecting the Sensor and Float to the Monitor .......... 3-42
Securing the Dryer Tube to the Monitor ............... 3-45

Chapter 4 Communication

4-1

Setting Up Wireless Communication ............................. 4-2
Installing the Antenna ............................................. 4-2
Installing the SIM Card ......................................... 4-17
Providing Telephone Service ....................................... 4-22
Running the Telephone Cable Between the
Monitor and Service Locations ...................... 4-22
Mounting the Lightning Protection Module .......... 4-25
Preparing the Telephone Cable ............................. 4-26
Wiring the Telephone Cable to the Monitor ......... 4-28
Wiring the Telephone Cable to the Lightning
Protection Module.......................................... 4-30
Wiring the Lightning Protection Module to the
Network Interface Box ................................... 4-32
Connecting to the Monitor in the Field ........................ 4-35

Chapter 5 Configuration and Activation 5-1
Configuring the Monitor Location ................................. 5-2
Launching the Profile Software ............................... 5-2
Creating a Monitor Location ................................... 5-4
Creating an Installation Table ................................. 5-6
Selecting and Editing Devices ............................... 5-11
Setting the Communication Parameters ........................ 5-20
Activating the Monitor ................................................. 5-24
Configuring the Power Savings Parameters ................. 5-27
Running Device Diagnostics ........................................ 5-32
Collecting Data from the Monitor ................................ 5-37
Upgrading the Monitor Firmware................................. 5-44
Viewing Diagnostic and Data Logs .............................. 5-47

Table of Contents

Chapter 6 Monitor Installation

v

6-1

Mounting the Monitor to the Manhole Wall................... 6-3
Mounting the Monitor to the Manhole Rim.................... 6-6
Mounting the Monitor to a Manhole Ladder Rung....... 6-12

Chapter 7 Maintenance and
Troubleshooting

7-1

Maintaining the System Components ............................. 7-2
Gathering Replacement Parts and Supplies ............. 7-2
Inspecting the Monitor ............................................ 7-3
Checking the Sensor and Float Switch .................... 7-9
Checking Communication Devices ....................... 7-10
Troubleshooting ........................................................... 7-12
General Monitor Problems .................................... 7-13
General Communication Problems........................ 7-16
General Pressure Depth Problems ......................... 7-20
General Float Switch Problems ............................. 7-21

Appendix A Specifications

A-1

ADS FlowAlert Monitor ........................................ A-1
Printed Circuit Board ............................................. A-3
Pressure Depth Sensor............................................ A-4
Float Switch ........................................................... A-5
Lightning Protection Module ................................. A-6

Appendix B Part Numbers

B-1

1-1

CHAPTER 1

Introduction

The ADS® FlowAlert™ monitor measures and records flow depth in
sanitary sewers, storm sewers, pump stations, and other
environments at strategic locations to assist municipalities and other
industry in detecting and monitoring backups, overflows, and
surcharges. It also supports high and low depth alarming and
system event notification. These capabilities are essential to
providing ongoing oversight and maintenance as well as ensuring
timely notification and rapid response in potentially critical
situations.
The battery-powered, microprocessor-based FlowAlert monitor
displays exceptional accuracy and reliability in measuring and
detecting changes in flow depth, even in the most challenging
monitoring environments.
This manual offers detailed instructions on installing the FlowAlert
monitor and supporting devices, providing (wireless, landline, and
direct, on-site) communication with the monitor, and performing
routine maintenance and troubleshooting on the system.
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Warnings and FCC Compliance
Manhole and sewer system work involves confined space entry and
is inherently dangerous. Therefore, installers and technicians
should comply with all federal, state, and municipal regulations
concerning confined space entry.
In addition, personnel installing and maintaining this equipment
should follow all guidelines presented in this manual concerning
monitor installation and maintenance. Failure to strictly adhere to
these guidelines can result in personal injury and/or damage to the
monitor.
Note: FlowAlert monitors are not intrinsically safe and,
therefore, should not be used in areas containing known
atmospheric hazards.

Communications Disclaimer
ADS monitoring and alarming products use publicly available
landline telephone or third-party GSM/GPRS wireless
communication services and, therefore, cannot control the
availability of these services. For applications where ADS systems
provide alarms, problems at the carrier level can delay or totally
prevent the delivery of alarm messages. If the user has questions
regarding the availability of services in an area or
outages/interruptions that may have affected service, the user should
contact the telephone company or wireless provider directly.

Introduction
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FCC Part 68 Compliance (applies only to
Landline Units)
To comply with the Federal Communications Commission (FCC),
ADS Environmental Services provides the following information
concerning FlowAlert flow monitor installation and operation.
This equipment complies with FCC Rules, Part 68. It bears a label
displaying the FCC Registration Number. The user must provide
this information to the telephone company if requested.
The telephone company may make changes in its facilities,
equipment, operations, or procedures that could affect the operation
of this equipment. If this occurs, the telephone company will
provide advance notice so the user can make necessary
modifications to maintain uninterrupted service.
In the unlikely event that this equipment harms the telephone
network, the telephone company will notify you that temporarily
discontinuing telephone service may be required. Notification will
occur in advance of discontinuation, or as soon as practically
possible. They will also inform the user of the right to file a
complaint with the FCC if necessary.
This equipment may not be used on public coin phone service
provided by the telephone company. Connection to party line
service is subject to state tariffs.

FCC Part 15 Compliance
This equipment has been tested and found to comply with the limits
for a Class A digital device pursuant to Part 15 of the FCC rules.
These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and if not
installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular
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installation. If this equipment does cause harmful interference to
radio or television reception (which can be determined by turning
the equipment off and on), the user should try to correct the
interference by one or more of the following measures:


Reorient or relocate the radio or television antenna.



Move and/or increase the distance between the monitor and the
radio or television.

If these suggestions do not help, the user should contact the ADS
Client Services Department at adssupportcenter@idexcorp.com or
877-237-9585 or an experienced radio/television technician.

GSM/GPRS Modem Information
The wireless version of the ADS FlowAlert contains a third party
GSM/GPRS modem manufactured by Enfora, Incorporated. The
modem model number is GSM0108IG001, description “Enabler IIG Quad-Band GSM/GPRS Radio Modem”, FCC ID
MIVGSM0108. Users of products containing the GSM0108
modem must be aware of the following:
Contains FCC ID: MIVGSM0108
This device complies with Part 15 of the FCC Rules. Operation is
subject to the following conditions: (1) This device may not cause
harmful interference, and (2) This device must accept any
interference received, including interference that may cause
undesired operation.
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Installation and Configuration
Following is the general procedure for installing and configuring a
FlowAlert monitoring system. Refer to Chapters 3 through 6 for
detailed instructions and information.


Investigate the Site Characteristics



Install the Pressure Depth Sensor
•

Assemble the Ring (when applicable)

•

Mount the Sensor to the Ring or Special Bands (when
applicable)

•

Secure the Sensor Cable to the Ring or Special Bands
(when applicable)

•

Install the Pressure Depth Sensor

•

Secure the Sensor Cable in the Pipe and the Manhole



Install the Float Switch(es) in the Manhole



Connect the Sensor and Float Switch to the Monitor



Attach the Dryer Tube to the Monitor



Establish Wireless, Telephone, or On-Site
Communication with Monitor



Configure the Monitor (using Profile Software)

®

•

Create the Monitor Location

•

Create the Installation Table (when necessary)

•

Select and Edit the Devices



Set the Communication Parameters (Profile)



Activate the Monitor (Profile)



Run Diagnostics and Perform Confirmations (Profile)



Install the Monitor in the Manhole
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Product Warranty
This section includes the warranty information for the ADS
FlowAlert.

New Product Warranty
All new products manufactured by ADS will be free from defects in
material and workmanship for up to one (1) year following the date
of shipment from ADS. During this warranty period, upon
satisfactory proof of a defect, the product may be returned for repair
or replacement, at ADS’s sole option. No returns will be accepted
unless the Owner has prepaid shipping and has received a prior
authorization return number from ADS. Please contact ADS to
obtain an authorization return number. Warranty repairs and
replacements will be performed only by ADS. Any unauthorized
repair or replacement will void this product warranty. Any repair or
replacement will be covered by this new product warranty for ninety
(90) days from the date that such repaired or replaced product is
shipped from ADS. This warranty is available only if the product
has been installed and operated in accordance with the procedures
outlined in the ADS Operations and Maintenance Manual. This
warranty does not apply to damage by catastrophes of nature, fire,
explosion, acts of God (including, but not limited to, lightning
damage and power surges), accidents, improper use or service,
damage during transportation, or other similar causes beyond
ADS’s control.

Out-of-Warranty Product Repairs
After the new product warranty expires, a product may be returned,
at the owner’s prepaid expense, to ADS for repair. The owner will
pay for all parts and labor associated with the repair. Any repair
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part will be covered by the new product warranty for 90 days from
the date of shipment from ADS.

Troubleshooting Fee
ADS will charge a troubleshooting fee if the reported product defect
cannot be found and/or the reported defect is not due to a defect in
materials or workmanship.

Shipping
All repaired products will be returned via surface transportation
prepaid by ADS. Import duties, fees, taxes, and other related
charges are the responsibility of the owner.
THIS IS THE ONLY WARRANTY FOR ADS PRODUCTS.
NO OTHER WARRANTY IS EXPRESSED OR IMPLIED,
INCLUDING FITNESS FOR A PARTICULAR PURPOSE OR
MERCHANTABILITY. PRODUCT REPAIR OR
REPLACEMENT IS THE ONLY REMEDY. IN NO EVENT
WILL ADS BE RESPONSIBLE FOR ANY DIRECT,
INDIRECT, CONSEQUENTIAL, OR SPECIAL DAMAGES.
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CHAPTER 2

System Overview

The ADS® FlowAlert monitor is a data logger and alarm system
that uses up to two devices to measure or detect fluid levels: a
pressure depth sensor and up to two float switches. The pressure
depth sensor is a gauge-type sensor provided by ADS for mounting
in the pipe or on the manhole or vessel wall. The float switch(es) is
suspended in such a way that it becomes buoyant and trips its
internal contact at a predetermined, fixed elevation.
The monitor receives the raw pressure depth data and float state
from the sensor and float, respectively, based on a defined time
interval. The float also can provide instantaneous notification when
changes in state occur. The monitor stores this data in memory and
can use the data to generate an alarm. The multiple depth devices
help enhance these alarming capabilities.
The monitor memory can store a little over 2 years of data logged at
a 15-minute sample rate. This data is available to the user for
collection, further processing, analysis, and reporting. These
reports can assist municipalities and other industry in planning
improvements and additions to sewer systems and providing
information for the overall management of the sewer system.
The FlowAlert monitor, pressure depth sensor, and float switch are
primarily designed for use in sanitary and storm sewers and pump
station wet wells. The monitor mounts to the manhole rim or wall
slightly below the manhole cover. The pressure depth sensor
typically attaches to a ring installed in the sewer pipe a short
distance upstream from the manhole invert at a location called a
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monitoring point. The float switch hangs suspended in the middle
of the manhole and is secured just below the manhole rim by its
cable. This equipment displays exceptional durability and accuracy,
even under harsh and turbulent flow monitoring conditions.

Typical FlowAlert system installation

Communication between the monitor and the user’s office or field
computer can occur over GPRS (remote, wireless communication),
a telephone line (remote, landline communication), or a direct
connection cable (on-site communication).
Special software called Profile® enables the user to configure and
communicate with the monitor for activation, data collection, and
diagnostic purposes. Configuration involves defining the location
information file (LIF) for storage in the user's local directory and
building the code and variables for the site. The LIF contains
information such as pipe characteristics, monitor identification,
selected devices, alarm/event notification settings, data log rate, and
other parameters necessary for measuring and monitoring the flow
depth both accurately and efficiently.

System Overview
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Activation involves downloading the firmware (embedded software)
code and site-specific information from the LIF (stored in the user's
local directory or network drive) to the monitor. It also includes
initiating monitor activities such as taking sensor readings, logging
flow data, and managing event notification and alarming.
Profile also enables the user to process the flow data, generate
graphical and tabular reports, organize data in the user's local
directory, and maintain logs of communication between the monitor
and the user's PC.
Note: Refer to the Profile User's Guide (#950015**) for
more information.
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ADS FlowAlert Monitor
The ADS FlowAlert monitor is a waterproof, airtight, cylindrical,
marine-grade aluminum canister housing a printed circuit board and
an alkaline battery pack.

Typical FlowAlert flow monitor with printed circuit board (left) and battery
removed from enclosure (right)

The following table contains the available FlowAlert Monitors:
Part Number

Description

6000-FAW

Internal Battery, Wireless Modem

6000-FAL

Internal Battery, Landline Modem

Printed Circuit Board
The circuit board, attached to the inside of the monitor lid, supports
the following:


Digital Signal Processing



Input Device (pressure depth and float switch) Processing



Communications (modem and radio)



Voltage Regulation

System Overview
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Printed circuit board (PCB)

Digital Signal Processing
The Digital Signal Processor (DSP) contains the central processing
unit (CPU). As the source of all monitor activity, the processor is
responsible for all of the monitor's high-level functions, including
the following:


Scanning the sensor and float switch inputs to retrieve data for
processing and storage



Maintaining the monitor time and date



Performing power management



Transmitting the stored and current data to the user's PC



Initiating event and alarm notification

The DSP allocates portions of memory to firmware (permanently
stored software) and data storage. A seven-segment (SS) lightemitting diode (LED) located on the board indicates the current
monitor communication and operational activity. The DSP also

2-6

ADS FlowAlert Manual
includes the monitor clock, random access memory (RAM), and
Flash. The monitor uses RAM while taking readings and
processing the flow data. The RAM then downloads the data to
Flash, or non-volatile memory, which also stores the monitor
firmware and configuration information. Flash ensures the monitor
maintains the data during battery pack replacement or a power
failure.

Input Device Processing
The input component of the board controls the processing of the
pressure depth sensor and the float switch. It initiates pressure
depth sensor readings and requests for the float switch state. The
board also processes the solicited (and unsolicited) data received
and stores it in the monitor memory.

Communications
The communications component of the board provides multitasking/handling of all communications processes. It interfaces to a
landline or wireless modem (based on the model of FlowAlert), as
well as manages local serial communication requests. The
communications component also is responsible for gathering realtime information from the other components on the board.

Voltage Regulator
The voltage regulator regulates and distributes power supplied from
the battery pack to the analog, communications, and DSP
components on the board.

Communications
ADS offers two remote communication options for the FlowAlert
monitor. The first option involves wireless communication over the
cellular network using GPRS (General Packet Radio Service)
through the modem in the monitor. GPRS facilitates high-speed,
low-cost, efficient TCP/IP communication in areas with AT&T

System Overview
wireless coverage. The second option involves telephone
communication over land lines using the modem in the monitor.
Local communication with all FlowAlert monitors is available
through a direct serial cable connected to the DIRECT
COMM/EXT POWER port.

Connectors
Connectors located on top of the monitor receive the following
cabling and components:
Note: Connectors available depend on the FlowAlert
model. Refer to the appendices for specifics on different
model types and functionality.
Pressure depth sensor/float switch(es)



Direct (on-site) communication/external power



Telephone/antenna (wireless) communication



Air pressure valve (for testing purposes only)
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Power
The ADS FlowAlert Monitor is powered by an internal 7.5 volt
alkaline battery pack (ADS p/n 6000-0004) mounted at the bottom
of the enclosure. This battery pack provides the power for
operating the monitor, handling communication, and sustaining the
monitor wake-up circuitry. The monitor measures the battery
voltages, and Profile provides a user-defined setting to ensure the
monitor signals a warning when the available power is low.
Battery voltage is logged during most communication sessions and
also is available on demand when performing diagnostics.

FlowAlert 7.5-volt battery pack

System Overview
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Flow Depth Devices
The FlowAlert monitor uses measurement devices to gather flow
depth data or status. The pressure depth sensor obtains static gauge
pressure data for use in determining the depth of the flow. The float
switch provides status (or state) information regarding its position
to indicate whether the depth of the flow has exceeded beyond or
fallen below a certain threshold.

Pressure Depth Sensor
The pressure depth sensor (ADS p/n 3704-0010/15/16 –
representing 5/15/30 psi pressure sensor ranges, respectively)
mounts to a stainless steel expandable ring or stainless steel band
installed in the pipe upstream from the manhole or to a small
stainless steel band secured to the manhole/wet well wall.

Pressure depth sensor

A sewer system's hydraulics are much more stable and uniform in
the incoming pipe than in the manhole invert or outgoing pipe.
Installing it upstream minimizes hydraulic effects and erroneous
data readings caused by flow waves and obstructions in the
manhole. Therefore, install the sensor in the incoming pipe (at or
near the bottom of the pipe) for accurate depth measurements.
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If accurate depth measurements are not necessary or applicable,
mount the sensor to the wall of the manhole or wet well.
The pressure depth sensor can measure depths greater than a full
pipe that might extend up into the manhole (i.e., surcharges). The
FlowAlert supports pressure sensors with ranges from 0-5 (11.5), 015 (34.5), and 0-30 PSI (69.0 ft).
The pressure depth sensor contains a differential pressure
transducer that transmits an output voltage corresponding to the
difference between the water pressure and the air pressure in the
sewer. It measures water pressure through a port on the underside
of the sensor and air pressure using an integral vent tube running to
the top of the manhole. The monitor calculates the depth of the
flow by reading the difference in pressures.

Float Switch
The float switch typically is anchored just below the manhole rim
and hangs suspended in the center of the manhole from its
supporting cable at an elevation designated in the project
requirements. It includes an integrated switch and weight system
that enables the float to change position (which activates a switch)
when the flow elevates to and recedes from a specific elevation in
the manhole. This elevation represents the point at which the state
of the switch changes. The FlowAlert receives notification from the
float whenever the change in state occurs.

System Overview
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High and High-High float switches

When the float is suspended vertically above the fluid, the internal
switch remains in a closed state. If the depth level rises and
contacts the end of the float, the internal weight allows the float to
begin to pivot into a horizontal position. If the end of the float rises
slightly above this position (5 degrees above horizontal), the switch
transfers to an open state and communicates the change in state to
the FlowAlert monitor for logging and/or alarming purposes. When
the depth level recedes and the end of the float falls below the
switch threshold, the switch returns to a closed state once again.

Float switch changing orientation with rising flow
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CHAPTER 3

Pressure Depth Sensor and Float
Switch Installation

The ADS® FlowAlert monitor, pressure depth sensor, and float
switch are primarily designed for monitoring flow in sanitary,
combined, storm sewers, and pump station wet wells. The monitor
mounts to the manhole rim or wall slightly below the manhole
cover.
The pressure depth sensor can mount to a stainless steel, expandable
ring or a stainless steel band installed in the sewer pipe a short
distance upstream from the manhole invert. A sewer system’s
hydraulics are much more stable and uniform in the incoming pipe
than in the manhole invert or outgoing pipe. Installing the sensor
upstream minimizes the hydraulic effects and erroneous data
readings caused by conditions in the pipe and the manhole.
The pressure depth sensor also can mount to a short, stainless steel
strap secured to the wall of the manhole or wet well when flow
depth measurements in the pipe are not applicable or necessary.
The float switch hangs from its cable in the center of the manhole,
and the cable is secured just below the manhole rim. Hanging the
float in the center prevents it from contacting or becoming tangled
with other objects in the manhole that may keep it from pivoting
properly when the flow rises or recedes.
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Following are the basic steps for installing the FlowAlert monitor,
pressure depth sensor, and float switch at a location:


Investigate the Site Characteristics These characteristics
include pipe size and shape, silt level, flow depth, and manhole
depth, environment, and obstructions.



Install the Sensor The procedure varies based on the sensor
mounting location:
 In the Pipe This process primarily includes assembling
the ring (for standard installations) or preparing the band
(for special installations) to which the pressure depth
sensor attaches, securing the sensor cable to the ring or
band, and installing the ring or band in the pipe.
 In the Manhole/Wet Well This process primarily
involves attaching the pressure depth sensor to the
mounting strap and mounting the strap in the manhole/wet
well.



Secure and Connect the Cable This procedure involves
securing the pressure depth sensor cable from the ring, band, or
strap to the monitor location in the manhole.



Install the Float Switch in the Manhole This process
includes lowering the float switch to the proper elevation in the
manhole and then securing the float switch cable to the
appropriate location in the manhole.



Connect the Sensor and Float to the Monitor This
involves connecting the pressure depth sensor and float
switch(es) to the FlowAlert monitor.

Pressure Depth Sensor and Float Switch Installation 3-3

Typical FlowAlert flow monitor, sensor, and float installation

This chapter contains detailed instructions for properly installing a
pressure depth sensor and a float switch(es) in sanitary, storm, and
combined sewer lines; manholes; and pump station wet wells.
Note: Manhole and sewer system work involves confined
space entry and is inherently dangerous. Therefore,
installers and technicians must comply with all federal,
state, and municipal regulations concerning confined space
entry. ADS is not responsible for any injuries, damages,
claims, or liability resulting directly or indirectly from the
use of this installation guide or the installation of any ADS
equipment.
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Investigating Site Characteristics
Before beginning installation activities, conduct a thorough
investigation of site conditions. The physical characteristics of the
pipe affect the flow and determine the procedure for installing the
pressure depth sensor. The manhole environment can affect the
installation and effective operation of the float switch(es). Consider
the following factors and perform the following activities when
installing the sensor, float switch(es), and monitor:


Sensor Installation Method The mounting location
determines the installation method employed for installing the
pressure depth sensor. For pipe installations, pipe size and
shape also influence the method used.
 Standard Installation Select this option to install the
sensor in a round pipe from 8 to 48 inches in diameter.
Standard installations involve attaching the sensor to an
adjustable stainless steel ring that mounts inside the pipe.
 Special Installation Select this option to install the
sensor in a non-round pipe or a round pipe larger than 48
inches in diameter. Special installations involve attaching
the sensor to a steel band secured to the inside of the pipe.
 Wall Installation Select this option to install the sensor
in a manhole or pump station wet well. Wall installations
involve attaching the sensor to a steel strap secured to the
wall.



Pipe Height and Width Measure and record the horizontal
and vertical pipe dimensions.
Note: Specific measurements for pipe height, width, and
shape are required only if the project requires using the
depth data to calculate flow quantity. All relevant pipe
dimensions and measurements must be available for entry
in the Profile® software during monitor configuration and
activation.

Pressure Depth Sensor and Float Switch Installation 3-5



Pipe Shape Taking the appropriate measurements that
precisely reflect the exact pipe shape is essential to obtaining
accurate flow calculations. Therefore, irregular-shaped pipes
will require additional measurements if accurate flow
measurements are essential. Refer to the Profile User’s Guide
(#950015**) for more information.



Manhole Depth Measure the distance from the top of the
manhole to the bottom of the manhole invert. This
measurement may be required to determine the elevation for the
float switch. Distances beyond 35 will require extension cables
for the sensor. Manhole depth and expected surcharge levels
also determine the PSI of the pressure depth sensor to install.



Manhole Obstructions Carefully inspect the manhole for
possible obstructions that may pose a hazard to the hanging
float switch or prevent the float from freely changing position
when the flow is rising or receding. Obstacles or obstructions,
such as ledges, can create an opportunity for the float to
become lodged, producing an inaccurate representation of the
float switch state.
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Installing the Sensor in the Pipe
This section includes the procedures for performing pressure depth
sensor installation using one of the following methods:


Standard Installations



Special Installations

Standard Installation
Performing a standard sensor installation involves the following
process:


Gathering the parts and supplies



Gathering the tools and equipment



Assembling the ring



Mounting the sensor on the ring



Securing the cable to the ring



Installing the ring in the pipe

Gathering Parts and Supplies
Obtain the following supplies before installing the ring and sensor
to prevent any costly delays. When ordering, specify the FlowAlert
flow monitor ring-mounted installation hardware.

Pressure Depth Sensor and Float Switch Installation 3-7

Quantity

Description

ADS Part Number

1

FlowAlert flow monitor

6000-FAW or 6000FAL

1

monitor mounting bracket

I40-0003

1

pressure depth sensor with
two 4-40 x 5/16-inch stainless
steel screws

3704-0015-40 (15 psi)

3704-0010-40 (5 psi)
3704-0016-40 (30 psi)

1

replacement dryer tube

3704-0032

1

direct connection cable

5000-0601

15

¼- × 2 ¼-inch stainless steel
anchor bolts

I01-0002

1

3/8-inch x 3-inch anchor bolt
and nut

I01-0003

2

3/8-inch x 1-inch stainless
steel hex bolts

I01-0001

4

3/8 – 16 stainless steel hex
nuts

I15-0002

5

3/8-inch stainless steel flat
washers

I55-0001

1

3/8-inch x 2-inch studs

I01-0009

15

plastic push mounts

I01-0006

15

11-inch cable ties

I05-0003

25

4-inch cable ties

I05-0001

15

8-inch cable ties

I05-0002

15

anchor cable ties

I05-0004

1

stainless steel ring (sized for
pipe)

I25-0081 – I25-0094

1

stabilizer sliding bracket

I25-0002

1

spreader assembly

I10-0003

1

18-inch stainless steel crank
handle

I10-0012

3-8

ADS FlowAlert Manual

Gathering Tools and Equipment
Gather the following tools for the installation:


Battery-powered hammer drill with assorted bits – including
the following, at a minimum:
 ¼-inch x 6-inch masonry bit
 3/8-inch x 4-inch (minimum length) masonry bit
 5/16-inch carbide-tipped bit (include smaller bits)



4-pound hammer



Rubber mallet



24-inch carpenter’s level



7/16-inch nut driver



Wrenches



Screwdrivers (flathead and Phillips head of assorted sizes)



3/8 – 16 thread tap



Diagonal wire cutters



Folding carpenter’s rule with a brass slide



Rubber stretch tape

Assembling the Ring
The pressure depth sensor mounts to a stainless steel ring that is
installed in the pipe. Several different ring sizes exist, and each ring
is adjustable within about 3 inches to fit pipes of different
diameters. Assemble the ring as follows:
Note: These instructions generally apply to overlapping
rings. However, the 8-, 10-, and 12-inch rings do not have
an overlapping section. Therefore, these non-overlapping
rings will require small modifications to the assembly
process. To assemble a non-overlapping ring, proceed
directly to step 4.
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1.

Insert the spreader mechanism screw through the hole in the
center of the ring stabilizer. Ensure that the head of the screw
fits into the countersunk hole.

Ring stabilizer with spreader mechanism screw

2.

Slide the open end of the ring (end without the welded metal
band) through the flanges in the ring stabilizer, making sure the
flanges face the outside of the ring and the spreader mechanism
screw faces the inside of the ring.

Sliding the ring stabilizer onto the ring
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3.

Slide the ring stabilizer all the way around the ring until it is
about 4 inches from the welded metal band at the other end of
the ring.

Moving the ring stabilizer into position

4.

Position the ring with the downstream edge (edge with the
holes) facing you.
Note: Steps 5 and 6 apply only to overlapping rings.
Proceed directly to step 7 for non-overlapping rings.

5.

Slide the open end of the ring through the slot in the welded
band of the ring until it overlaps about 4 inches.

6.

Spread the ring sections apart so that you can slide the ring
stabilizer with the spreader mechanism screw into the gap.
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Moving the ring stabilizer into position

7.

Perform the following based on the ring type:
 Overlapping Insert the spreader mechanism screw
completely through the hole at the open end of the ring.
 Non-Overlapping Insert a spreader mechanism screw
through the hole at the left end of the ring so that the end
of the screw extends inside the ring.

Ring stabilizer fully connected

8.

Place the ring on a flat surface with the spreader mechanism
screw facing up.
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9.

Orient the ring with the downstream edge (edge with small
holes) facing you.

10. Lay the spreader mechanism across the inside of the ring with
the downstream end of the mechanism (end with the large
welded nut) facing you, the four spreader bars facing toward
the inside of the ring, and the shoulder bolts pointed outside the
ring.
11. Place a washer and then the downstream, left spreader bar over
the spreader mechanism screw.

Orienting and attaching the spreader mechanism

12. Place the upstream, left spreader bar onto the same screw.
13. Lightly turn the hex nut onto the screw, ensuring that it passes
through the holes in the end of the spreader bar.
Note: Steps 14 through 16 apply only to overlapping
rings. For a non-overlapping ring, proceed to step 17.
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Attaching the spreader bars

14. Turn the ring until the spreader mechanism is in the 12:00
position.
15. Align the spreader mechanism screw so that the head is visible
through one of the ring size adjustment holes.

Aligning the screw head and adjustment hole

16. Tighten the screw through the hole using a Phillips-head
screwdriver while holding the hex nut with a ½-inch nut driver.

3-14

ADS FlowAlert Manual

Tightening the spreader mechanism screw and hex nut

17. Insert the second spreader mechanism screw through the
following hole based on the ring type:
 Overlapping Appropriate ring size adjustment hole on
the outside of the ring
 Non-overlapping Last hole on the other free end of the
ring (inserting the screw from the outside of the ring)
18. Slip the large washer onto the screw on the inside of the ring.
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Place the washers onto the second spreader mechanism screw

19. Place the spreader bars over the screw, and tighten a hex nut on
the screw.

Spreader mechanism attached to the ring (view from inside the ring)
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Although the spreader mechanism fits snugly against the inside of
the ring, the spreader mechanism may seem loose on the hex nuts.
Do not be concerned. The spreader mechanism will tighten once
the ring is installed and tightened inside the pipe. The following
picture displays how a properly assembled ring should look.

Mounting the Pressure Depth Sensor to the Ring
The following section provides instructions on mounting the
pressure depth sensor to the ring. To ensure the most accurate flow
data, standard pipe installations require proper positioning of the
sensor on the ring as well as in the pipe. When facing the
downstream edge of the ring, the sensor should be mounted on the
bottom of the ring.

Proper positioning of sensor on the ring

Caution: Handle the sensor and cable with extreme care.
They contain delicate mechanisms and electronics. Keep
sharp objects away from sensor cable, and avoid stepping
or placing heavy objects on the cable during installation.
Mount the pressure depth sensor to the ring in the following way:
1.

Orient the ring so that the ring’s spreader mechanism is directly
on top.
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2.

Use two 4-40 x 5/16-inch stainless steel screws (do not
substitute any other screws) to mount the pressure depth sensor
on the bottom inside of the ring with the pointed end of the
sensor facing upstream. Mount the pressure depth sensor
slightly to the left of bottom center when excessive silt is
present.

Mounting the pressure depth sensor to the ring

3.

Secure the sensor cable to the ring. Refer to the next section,
Securing the Cable to the Ring, for instructions on properly
securing the cable.

Securing the Cable to the Ring
Securing the pressure depth sensor cable to the ring helps prevent
debris from collecting between the cable and the ring or catching on
the loose cable. It also prevents the loose cable from disrupting the
flow.
Secure the sensor cable in the following way:
1.

Starting at the sensor location, begin securing the cable with 4inch x 0.08-inch cable ties through the pre-drilled holes along
the downstream trailing edge of the ring up the side of the ring.
Run the cable up the side of the ring opposite the spreader
mechanism (the left side of the ring when facing the
downstream edge of the ring).
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Sensor cabling

2.

Continue securing the cables until reaching the top of the pipe.

3.

Pull the ties until they are taut.
Warning: Do not over-tighten the cable ties or kink the
sensor cable! The pressure depth sensor cable sheathes
two components: the electrical cables that operate the
sensor and an air tube that ventilates the sensor. Overtightening the ties or kinking the cable can damage or
restrict the air tube, causing incorrect pressure depth
readings. In addition, make sure the connector-end of the
sensor is not kinked, does not contain moisture, and
includes an attached dryer tube filled with active blue
desiccant.

4.

Use the diagonal cutters to cut off the excess portion of the
cable ties.

Installing the Ring in the Pipe
The ring must fit securely in the pipe with the sensors properly
positioned to ensure the most accurate monitoring results. Install the
ring in the pipe in the following way:
1.

Examine the pipe for possible obstructions to the flow or
inhibitors to ring installation.

2.

Adjust the ring size to slightly less than the pipe diameter
before placing the ring in the pipe by turning the spreader
mechanism adjustment nut clockwise.
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3.

Place the ring in the input pipe at least 12 inches upstream from
the manhole or edge of the pipe with the sensors facing
upstream toward the oncoming flow. It should be located far
enough upstream from the manhole to minimize the effect of
the draw-down caused by a possible drop in the manhole invert.

Installing the ring at least 12 inches upstream from the manhole invert

Keep the following in mind:
 Make sure the spreader mechanism is at the top (crown) of
the pipe and the pressure depth sensor is at or near the
bottom of the pipe, above any silt present and below the
flow surface (during minimum flows).

Proper orientation of the ring with the sensors in the pipe with and without
silt present
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 If necessary, temporarily clear away silt to install the ring.
Restore the silt after fully securing the ring (step 7).
 Make sure the ring is flat (flush) against the inside wall of
the pipe to avoid obstructing the flow or catching debris.
4.

Expand the ring by turning the spreader mechanism nut
counter-clockwise with the crank handle or socket. Continue
tightening the ring until it fits securely and completely flush
against the pipe wall.
Warning: Avoid over-tightening the ring. This could
bend the crank assembly.

5.

Restore any silt moved to its previous level, and confirm that
the pressure depth sensor is still above the silt level.

6.

When the sensor is not located at the bottom of the pipe,
determine the physical offset for the pressure depth sensor by
measuring the vertical distance from the bottom of the sensor to
the bottom, center of the pipe.
Note: This value will be necessary when configuring the
monitor using the Profile software.

7.

Secure the sensor cable from the ring to the future monitor
location in the manhole. Refer to page 3-36 for more
information.

Special Installations
A special installation involves installing the mounting hardware for
the pressure depth sensor directly to the pipe surface with anchor
bolts, without the use of spreader mechanisms or rings.
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Performing a special installation involves the following process:


Gathering the parts and supplies



Gathering the tools and equipment



Mounting the pressure depth sensor



Securing the cables to the band

Before beginning the installation, conduct a thorough investigation
of hydraulic and other site conditions. The hydraulics of a site
directly affect the monitor's ability to accurately measure flow
depth. In addition, measure the horizontal and vertical pipe
dimensions carefully.
Caution: Handle the pressure depth sensor and cable
with extreme care. The sensor and cable contain delicate
mechanisms and electronics. Keep sharp objects away
from sensor cable, and avoid stepping or placing heavy
objects on the cable during installation.

Gathering Parts and Supplies
Be sure to obtain the following supplies before performing a special
installation to prevent any costly delays. When ordering, specify
the FlowAlert monitor special installation hardware.
Quantity

Description

ADS Part Number

1

FlowAlert monitor

6000-FAW or -FAL

1

monitor mounting bracket

I40-0003

1

pressure depth sensor with two 440 x 5/16-inch stainless steel
screws

3704-0015-40 (15 psi)

3704-0010-40 (5 psi)
3704-0016-40 (30 psi)

1

replacement dryer tube

3704-0032

1

direct connection cable

5000-0601

15

11-inch cable tie

I05-0003

25

4-inch cable tie

I05-0001

15

8-inch cable tie

I05-0002
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Quantity

Description

ADS Part Number

10

anchor cable tie

I05-0004

15

¼- × 2 ¼-inch anchor bolt (with
7/16-inch nut and washer)

I01-0002

1

3/8- × 2-inch stud

I01-0009

1

3/8-inch x 3-inch anchor bolt and
nut

I01-0003

2

3/8-inch x 1-inch stainless steel hex
bolts

I01-0001

4

3/8 – 16 stainless steel hex nuts

I15-0002

5

3/8-inch stainless steel flat washers

I55-0001

2

4-40 × 5/16-inch screw

I35-0001

8

6-32 washer

I55-0002

4

6-32 × 1-inch machine screw

I35-0004

4

6-32 × 5/16 inch nut

I15-0003

15

plastic push mounts

I01-0006

1

special predrilled 8-foot metal band

I40-0007

Gathering the Tools and Equipment
Gather the following tools for the installation:


Battery-powered hammer drill with assorted bits – including
the following, at a minimum:
 3/8-inch x 4-inch (minimum length) masonry bit
 ¼-inch masonry bit (F35-0018)
 5/16-inch carbide-tipped drill bit (include smaller bits)



4-pound hammer



Rubber mallet



Wrenches



Screwdrivers (flathead and Phillips head of assorted sizes)
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3/8 – 16 thread tap



Diagonal wire cutters



Folding carpenter’s rule with a brass slide



Rubber stretch tape

Mounting the Pressure Depth Sensor
Two special installation methods are available for mounting the
pressure depth sensor:


¾-band mount



½-band mount

Both mounts require almost identical installation methods. The
only significant differences are that the ¾-band mount allows the
installer to secure the band to both sides of the pipe wall and to
position the pressure depth sensor at the bottom center of the pipe.
These options are not possible using the ½-band mount. Therefore,
the ¾-band mount is the preferable method for mounting the sensor.
However, a ½-band mount may be appropriate for monitoring under
the following circumstances:


Large pipes with deep minimum flows



Large pipes with excessive silt present
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½- (left) and ¾-band (right) mounts

¾-Band Mount
Perform the following procedure to mount the pressure depth sensor
in a pipe using the ¾-band mount:
1.

Use a hacksaw to cut the band to the appropriate length. Cut
the band so that, when installed, it will run approximately ¾ of
the length around the inside of the pipe.
Note: The metal bands come in 8-foot lengths. Some
larger pipes may require attaching two bands together. In
addition, for square-shaped pipes, use an 8-foot straight
metal strip.

2.

Determine which end of the band will be the long end (end
extending almost completely up one side of the pipe). For
cable routing purposes, ADS recommends reserving the left
side of the pipe (upstream from the manhole) for the long end
of the band.
Note: Position the edge of the band with the cable tie
holes (edge with small holes) facing downstream.

3.

Determine the appropriate location on the band to mount the
pressure depth sensor, making sure the sensor will be both
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above the silt level and below the flow surface during minimum
flows.
 If silt is not present, locate the sensor on the band so it will
be at the bottom center of the pipe once installed.
 If silt is present, locate the sensor slightly up the long end
of the band so it will be above the silt level once installed.
4.

Mount the sensor onto the inside of the band with two 4-40 x
5/16-inch countersink screws, making sure the pointed end of
the sensor faces the upstream edge of the ring (edge opposite
cable tie holes). If holes do not exist on the band at or near the
desired mounting location for the sensor or the sensor does not
have screw inserts, use two medium-sized cable ties to secure
the sensor to the ring. Crisscross the cable ties across the top of
the sensor and underneath the band.

5.

Secure the sensor cable along the downstream edge of the long
end of the band according to the instructions on page 3-29.

6.

Position the band in the pipe so that the sensor will remain
below the flow surface (even during minimum flows) and
above the silt level.

7.

Make sure two pre-drilled holes are visible above the flow
surface on the short end of the band. Maneuver the band so
that the lowest hole is almost at the flow surface.

8.

Mark the pipe wall through the lowest hole with a drill, and
install a ¼-inch x 2 ¼-inch anchor bolt with a pneumatic drill.

9.

Secure the band to the anchor bolt with a washer and nut.

10. Conform the band to the pipe wall around to the long end of the
band so that it is flush with the pipe wall.
Note: Temporarily remove any silt preventing the band
from sitting flush against the bottom of the pipe.
11. Install a ¼-inch x 2 ¼-inch anchor bolt through the pre-drilled
hole closest to the flow surface on the long end of the band, and
secure the band with a washer and nut.
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12. Make sure the band and sensor are flush against the pipe wall
with no gaps, and conform the rest of the band to the pipe wall.
13. Install ¼-inch x 2 ¼-inch anchor bolts, nuts, and washers at the
pre-drilled hole at the short end of the band and at the predrilled holes along the long end of the band (above the flow
surface) approximately every 12 to 24 inches to the top end of
the band.
Note: Whenever possible, secure the band with an
additional anchor bolt approximately 3 inches below the
flow surface on each side of the pipe. This will help
ensure that the band remains flush against the bottom of
the pipe below the flow surface.

Sensors mounted using a ¾-band mount in the pipe with and without silt

14. Measure the physical offset for the pressure depth sensor (i.e.,
the vertical distance from the bottom of the pressure depth
sensor to the bottom, center of the pipe).
Note: This value will be necessary when configuring the
monitor using the Profile software.
15. Run the sensor cable from the sensor location in the pipe to the
monitor location in the manhole according to the instructions
on page 3-36.
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½-Band Mount
Perform the following procedure to mount the pressure depth sensor
in a pipe using the ½-band mount:
1.

Use a hacksaw to cut the band to the appropriate length. Cut
the band so that, when installed, it will run almost completely
down the left side of the pipe.

2.

Determine the best location on the band to mount the pressure
depth sensor. The sensor should mount as close as possible to
the bottom of the band, making sure the sensor will be both
above the silt level and below the flow surface once installed.

3.

Mount the sensor onto the inside of the band with two 4-40 x
5/16-inch countersink screws, making sure the pointed end of
the sensor faces the upstream edge of the ring. If holes do not
exist on the band at or near the desired mounting location for
the sensor or the sensor does not have screw inserts, use two
medium-sized cable ties to secure the sensor to the ring.
Crisscross the cable ties across the top of the sensor and
underneath the band.
Note: The edge of the band with the cable tie holes is the
downstream edge.

4.

Secure the sensor cable along the downstream edge of the band
according to the instructions on page 3-29.

5.

Place the band in the pipe upstream at least 12 inches from the
manhole invert. Position the band on the left side of the pipe so
that the sensor will remain below the flow surface (during
minimum flows) and above the silt level.

6.

Orient the band so that one of the pre-drilled anchor bolt holes
is just above the flow surface.

7.

Spot drill the pipe wall through the hole, install a ¼-inch x 2 ¼inch anchor bolt, and secure the band to the anchor bolt with a
washer and nut.
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Note: Make sure the submerged portion of the band is
flush with the pipe wall. If it is not, remove the band and
conform the band to the pipe.
8.

Install a ¼-inch x 2 ¼-inch anchor bolt, washer, and nut below
the flow surface 1 to 3 inches away from the pressure depth
sensor on each side. This will hold the sensor securely against
the pipe wall and prevent the end of the band from twisting in
the flow or catching debris.

9.

Conform the portion of the band above the flow surface to the
pipe wall, and install an ¼-inch x 2 ¼-inch anchor bolt, nut,
and washer every 12 to 24 inches up to the top of the band.

Completed ½-band mount in pipe

10. Measure the physical offset for the pressure depth sensor (i.e.,
the vertical distance from the bottom of the sensor to the
bottom, center of the pipe).
Note: This value will be necessary when configuring the
monitor using the Profile software.
11. Run the sensor cable from the sensor location in the pipe to the
monitor location in the manhole according to the instructions
on page 3-36.

Pressure Depth Sensor and Float Switch Installation 3-29

Note: If the pipe is large and the pressure depth sensor
cable cannot reach the pipe crown, attach the sensor cable
to ½-inch PVC tubing and anchor the tubing to the wall.
This will help prevent sensor damage during heavy flow.

Securing the Cable to the Band
Securing the pressure depth sensor cable to the band helps prevent
debris from collecting between the cable and the band or catching
on the loose cable. It also prevents the loose cable from disrupting
the flow.
Secure sensor cable as follows:
1.

Starting at the appropriate sensor location, begin securing the
sensor cable with 4-inch x 0.08-inch cable ties through the predrilled holes along the downstream trailing edge of the band up
the side of the band. Run the cable up the left side of the band
(when facing the downstream edge of the band).

Sensor cabling

2.

Continue securing the cable until reaching the top of the pipe.

3.

Pull the ties until they are taut.
Warning: Do not over-tighten the cable ties or kink the
sensor cable! The pressure depth sensor cable sheathes
two components: the electrical cables that operate the
sensor and an air tube that ventilates the sensor. Overtightening the ties or kinking the cable can damage or
restrict the air tube, causing incorrect pressure depth
readings. In addition, make sure the connector-end of the
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sensor is not kinked, does not contain moisture, and
includes an attached dryer tube filled with active blue
desiccant.
4.

Use the diagonal cutters to cut off the excess portion of the
cable ties.
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Installing the Sensor in the Manhole
or Pump Station Wet Well
This section includes the procedure for mounting the pressure depth
sensor to the wall of a manhole or pump station wet well. Install the
sensor in the following way:
1.

Gather the parts listed on the following table:

Quantity

Description

ADS Part Number

1

FlowAlert monitor

6000-FAW or -FAL

1

monitor mounting bracket

I40-0003

1

pressure depth sensor with two 4-40 x
5/16-inch stainless steel screws

3704-0015 (15 psi)

3704-0010 (5 psi)
3704-0016 (30 psi)

1

replacement dryer tube

3704-0032

1

direct connection cable

5000-0601

15

11-inch cable tie

I05-0003

25

4-inch cable tie

I05-0001

15

8-inch cable tie

I05-0002

10

anchor cable tie

I05-0004

2

¼- × 2 ¼-inch anchor bolt (with 7/16inch nut and washer)

I01-0002

1

3/8- × 2-inch stud

I01-0009

1

3/8-inch x 3-inch anchor bolt and nut

I01-0003

2

3/8-inch x 1-inch stainless steel hex
bolts

I01-0001

4

3/8 – 16 stainless steel hex nuts

I15-0002

5

3/8-inch stainless steel flat washers

I55-0001

2

4-40 × 5/16-inch screw

I35-0001

8

6-32 washer

I55-0002
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Quantity

Description

ADS Part Number

4

6-32 × 1-inch machine screw

I35-0004

4

6-32 × 5/16 inch nut

I15-0003

15

plastic push mounts

I01-0006

1

sensor mounting strap

700-100238-00

2.

Gather the following tools and supplies:
 Battery-powered hammer drill with assorted bits –
including the following, at a minimum:
 3/8-inch x 4-inch (minimum length) masonry bit
 ¼-inch masonry bit (F35-0018)
 5/16-inch carbide-tipped drill bit (include smaller bits)
 4-pound hammer
 Rubber mallet
 Wrenches
 Screwdrivers (flathead and Phillips head of assorted sizes)
 3/8 – 16 thread tap
 Diagonal wire cutters
 Folding carpenter’s rule with a brass slide
 Rubber stretch tape

3.

Determine the appropriate location on the manhole or wet well
wall to mount the sensor.

4.

Hold the pressure mounting strap (ADS p/n 700-100238-00)
vertically against the wall at the selected location, and mark the
wall through the top hole of the strap.
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Desired orientation of pressure depth sensor and strap on wall

5.

Remove the strap, and drill a ¼-inch hole 2 ½ inches deep at
the mark.

6.

Install a ¼-inch x 2 ½-inch anchor bolt in the hole.

7.

Place the strap on the anchor bolt, and then mark the wall
through the bottom hole of the strap.

8.

Remove the strap, drill a ¼-inch hole 2 ½ inches deep at the
lower mark, and install a second anchor bolt.

9.

Secure the pressure depth sensor to the strap with two 4-40 x
5/16-inch countersink screws. The sensor mounts
perpendicular to the strap.

Attaching the pressure depth sensor to the pressure mounting strap

10. Place the strap onto the anchor bolts in the wall, and secure the
strap to the bolts using the corresponding nuts and washers
until snug.
11. Measure and record the pressure depth sensor’s physical offset
for entry later into the Profile software. The physical offset is
the distance from the manhole invert (or bottom of wet well) to
the nose of the sensor.
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12. Secure the sensor cable to the wall with an 8-inch by 0.14-inch
cable tie attached to a a plastic anchor every 18 to 24 inches
from the sensor to the monitor location. A loose cable could
present a manhole safety hazard or increase the potential for
sensor or monitor damage. If plastic anchors will not serve as
adequate anchors based on the structure of the manhole or wet
well wall, install ¼-inch x 2 ¼-inch bolts instead.
 Drill a 3/8-inch hole in the pipe crown.
 Drive the plastic anchor into the pipe with a hammer until
flush and secure.
 Run the cable tie through the loop in the plastic anchor and
around the cable.
 Tighten the cable tie around the cable, and cut off the
excess cable tie material.
Warning: Over-tightening the cable ties may damage the
sensor cable.
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Completed pressure depth sensor installation on manhole wall
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Securing the Sensor Cable in the Pipe
and Manhole
Securing the sensor cable from the ring (or band, when applicable),
along the pipe crown, and up the manhole helps prevent debris from
collecting on a sagging cable or between the cable and the pipe
crown.
Do not allow the sensor cable to hang down in the pipe or sag in the
manhole. Loose cables could present a safety hazard in the
manhole or increase the potential for sensor or monitor damage.
The cable should be secured along the pipe crown and manhole wall
under all circumstances.
Note: Do not secure a wireless communication antenna
cable with the sensor cable! Refer to Setting Up Wireless
Communication in Chapter 4, Communication, for
information on securing the antenna cable in the manhole.
Secure the cable from the ring (or band) to the monitor location in
the manhole in the following way:
1.

Wrap the cable with an 8-inch by 0.14-inch cable tie attached
to a plastic anchor installed at the top of the pipe.
Note: If a plastic anchor will not serve as an adequate
anchor for securing the cable based on the structure of the
pipe, install a ¼-inch x 2 ¼-inch bolt instead.
 Drill a 3/8-inch hole in the pipe crown.
 Drive the plastic anchor into the pipe with a hammer until
flush and secure.
 Run the cable tie through the loop in the plastic anchor and
around the cable.
 Tighten the cable tie around the cable, and cut off the
excess cable tie material.
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Warning: Over-tightening the cable ties may damage the
sensor cable.
2.

Secure the cable with a cable tie and plastic anchor every 18 to
24 inches along the pipe crown (when necessary) from the ring
to the manhole. If plastic anchors will not serve as adequate
anchors based on the structure of the pipe, install ¼-inch x 2
¼-inch bolts instead.

3.

Secure the cable every 18 to 24 inches up the side of the
manhole to the monitor location. A loose cable could present a
manhole safety hazard or increase the potential for sensor or
monitor damage. If plastic anchors will not serve as adequate
anchors based on the structure of the manhole wall, install ¼inch x 2 ¼-inch bolts instead.

Securing the sensor cable along the pipe and into the manhole
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Installing the Float Switch in the
Manhole
Installing the float switch(es) at the proper position and elevation in
the manhole is essential to ensuring the status readings received are
accurate and the float can pivot freely with changing flow
conditions. The elevation at which to hang the float largely depends
upon the project requirements and threshold of notification.
However, the optimal position at which to hang the float is the
center of the manhole above the top of the pipe, to avoid the flow
line. Positioning the float in the center minimizes the possibility of
the float encountering potential hazards or obstructions present in
the manhole, particularly while swaying or pivoting.
Because the float switch is suspended in the air or flow, it must be
secured by its cable. Typically, the optimal location at which to
secure the cable is at the top of the manhole just below the rim.
This is the best way to position the float as close as possible to the
center of the manhole and to make it accessible for service or
replacement.
Warning: When installing floats in or adjacent to pump
stations or other facilities with rotating machinery (such as
mixers), ensure the customer signs off on the installation.
If a float and cables were to come loose, they would cause
severe damage to any downstream rotating machinery.
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Gathering Parts and Supplies
Obtain the following supplies before installing the float switch(es)
to prevent costly delays.
Quantity

Description

ADS Part Number

1

FlowAlert monitor

6000-FAW or -FAL

1

monitor mounting bracket

I40-0003

1

1 float switch (no pressure)

6000-0015-xx (xx
represents the
cable length in feet)

2 float switches (no pressure)

6000-0025-xx (xx
represents the
cable length in feet)

2 float switches and pressure pigtail

6000-0026-xx (xx
represents the
cable length in feet)

1 float switch and pressure pigtail

6000-0027-xx (xx
represents the
cable length in feet)

1

direct connection cable

5000-0601

10

anchor cable tie

I05-0004

15

¼- × 2 ¼-inch anchor bolt (with 7/16inch nut and washer)

I01-0002

Gathering Tools and Equipment
Gather the following tools for the installation:


Battery-powered hammer drill with assorted bits – including
the following, at a minimum:
 3/8-inch x 4-inch (minimum length) masonry bit
 ¼-inch masonry bit (F35-0018)
 5/16-inch carbide-tipped drill bit (include smaller bits)
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4-pound hammer



Wrenches



Screwdrivers (flathead and Phillips head of assorted sizes)



3/8 – 16 thread tap



Diagonal wire cutters



Folding carpenter’s rule with a brass slide



Rubber stretch tape

Mounting the Float Switch
Install the float switch in the following way:
Note: Floats are labeled HIGH and HIGH HIGH.
Therefore, always mount the HIGH float at the lowest
monitoring elevation.
1.

Install a ¼-inch x 2 ¼-inch anchor bolt in the manhole wall just
below the rim. Select a location away from the monitor
mounting location and on the opposite side of the manhole
from the rungs. This will reduce the possibility of the float
switch and its cabling striking or getting tangled in the rungs or
monitor.

2.

Establish the proper elevation (representing the trip point) at
which to hang the float switch, and then determine the distance
from that elevation to the anchor bolt.

3.

Measure that same distance from the top of the float switch (top
of the float’s collar where the enclosure meets the cable) up the
cable.

4.

Secure the cable to the anchor bolt using an anchor cable tie at
that location on the cable.

5.

Slowly lower the float switch into the manhole until it is fully
suspended from the mounting location.
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Float switch suspended in manhole in relation to rungs and monitor

6.

(applicable only for an additional float switch) Mount the
second float switch so that is secured at least 12 inches away
from the first float switch and adequately away from other
potential obstructions. Projects incorporating a second float
switch typically involve suspending the float switch at a
different elevation than the first float switch.
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Connecting the Sensor and Float to
the Monitor
After installing the pressure depth sensor and the float switch and
completely securing their cables, connect the sensor and/or float to
the FLOATS/PRESSURE port on the top of the monitor.
Applications involving pressure depth sensors and customer
supplied floats/relays require connecting an intermediate adapter
cable (pigtail) between the sensor/customer-supplied hardware and
the monitor.
The following table indicates the part numbers for the cables and
pigtails required for each application:
Description

ADS Part Number

Floats & Pressure pigtail (for
customer-supplied floats or relay
contacts)

6000-0013

Pressure pigtail

6000-0014

Floats pigtail (for customer-supplied
floats or relay contacts)

6000-0021

1 float

6000-0015-20/40/60

2 floats

6000-0025-20/40/60

2 floats & pressure pigtail

6000-0026-20/40/60

1 float & pressure pigtail

6000-0027-20/40/60

Connect the cables to the monitor port in the following way:
1.

Place the monitor in an upright position to view the monitor
connector ports.
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2.

Visually inspect the connectors on the cable(s) and adapter
(when applicable) and the FLOATS/PRESSURE connector
port on the monitor for debris or moisture. Clean off any
debris, and dry any surface moisture. Compressed air is useful
for removing moisture from the inside of the connectors or
ports (pin and socket surfaces).

3.

Verify that the interfacial seal is present inside each connector
with pins. The bright orange, rubber seal should sit at the
bottom of the connector with the pins protruding through the
seal.
Note: If the user is connecting the floats pigtail (ADS p/n
6000-0021) to customer-supplied contacts, prepare this
connection before connecting the cable to the monitor.

4.

Connect the float switch(es) cable, pigtail, or combination
cable to the FLOATS/PRESSURE port on the monitor.
Tighten the connector in a clockwise direction until it clicks,
and verify that it is seated correctly.

5.

(applies only when using pressure depth sensor) Connect the
pressure depth sensor cable to the mating connector on the
pigtail. Tighten the connector in a clockwise direction until it
clicks, and verify that it is seated correctly.

6.

(applies only when using customer-supplied floats or relays)
Connect the customer-supplied hardware cable to the
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corresponding connector(s) on the pigtail. Tighten the
connector in a clockwise direction until it clicks, and verify that
it is seated correctly.
7.

For locations exhibiting the presence of hydrogen sulfide
and/or high moisture, provide added protection by wrapping
the connection with rubber stretch tape.

8.

Seal any unused connectors with a cap. If necessary, obtain
additional caps from the regional ADS representative.
Note: An air valve is present on the top of the monitor.
This valve exists only for testing purposes during the
manufacturing process. Please do not attempt to fill the
monitor with air or pressurize the monitor! In addition,
make sure the cap is tight on the air valve to prevent the
valve components from corroding.
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Securing the Dryer Tube to the Monitor
Secure the dryer tube to the monitor in the following way:
1.

Attach the dryer tube from the pressure depth sensor in the
vertical position to the monitor handle and chassis bolt using
cable ties.

Securing the dryer tube to the monitor using cable ties

2.

Make sure the black end cap on the dryer tube is removed
before installing the monitor in the manhole.
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CHAPTER 4

Communication

After installing the pressure depth sensor, securing the float
switch(es) in the manhole, and connecting the cables to the monitor,
it is necessary to establish communication with the monitor (through
wireless communication, telemetry, or the direct serial connection)
to activate the monitor. This chapter contains instructions on
establishing a wireless connection or telephone service at the
monitor location for communicating with the monitor remotely and
using the direct serial cable to communicate with the monitor onsite. It also includes basic information concerning monitor
activation.
Note: Manhole and sewer system work involves confined
space entry and is inherently dangerous. Therefore,
installers and technicians must comply with all federal,
state, and municipal regulations concerning confined space
entry. ADS® is not responsible for any injuries, damages,
claims, or liability resulting directly or indirectly from the
use of this installation guide or the installation of any ADS
equipment.
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Setting Up Wireless Communication
Setting up wireless communication involves installing the antenna at
the monitor location, connecting the antenna to the monitor, and
installing the SIM card in the monitor.
Note: ADS wireless communication products use static
IP address network services provided by AT&T.
Therefore, any installation location designated for wireless
communication must have access to AT&T 850 or 1900
MHz service. Each wireless device will be fitted with a
SIM (Subscriber Identity Module) card that is provisioned
by AT&T with specific account and network information
for use with ADS software.
Note: Customer-supplied SIM cards cannot be used with
the ADS FlowAlert™.

Installing the Antenna
ADS provides three options for installing the wireless antenna:


In Road This option involves installing the antenna directly in
the road, in dirt, or under other paving materials.



Pedestal This option involves securing the antenna inside a
telecom pedestal installed off the road. ADS recommends
choosing this option when signal strength is poor using road
antennas.



Magnetic Whip This option involves securing the antenna to
a roof or other protected structure where only a minimal
opportunity exists for theft or vandalism.
Note: While this manual describes the installation process
for each antenna option, detailed installation instructions
also accompany all wireless antennas received from ADS.
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Installing a Wireless Antenna in the Road
Install a wireless antenna in the road in the following way:
1.

Gather the following parts and tools:
 Wireless slim or mini-wing, quad-band antenna (ADS p/n
3800-0162/0163 with SMA connector)
 (for off-road installations only) Extension cables for
antennas (15-foot: ADS p/n 507165; 50-foot: 507168)
 Medium-sized non-rotating demolition hammer with a ½-,
¾-, or 1-inch masonry chisel (sharpen the chisel before
use) and bushing tool, or an abrasive saw or grinder
 Medium to heavy duty hammer drill (if no hammer/drill
mode is available on the demolition hammer)
 Generator or other power source to power hammer
 ½-inch x 36-inch (minimum length) masonry drill bit (for
hammer drill)
 1 ¼-inch x 12-inch masonry drill bit (for hammer drill)
 Trowel or putty knife for scooping asphalt
 Hammer
 Carpenter’s rule
 Pen, pencil, or chalk for marking asphalt or concrete
 Shop vacuum
 Wire brush
 Alcohol wipes
 Leather work gloves
 Protective goggles
 Heavy duty, high-quality caulking gun (for regular-sized
tubes)
 Masonry drill bit and screws (included with kit)
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 Dry sand
 Commercial asphalt cold patch compound (1 cup)
 Scotch-kote electrical sealing compound (ADS p/n
505171)
 Scotch 130C rubber stretch tape (ADS p/n I45-0001)
2.

Determine the appropriate location in the road near the
manhole to install the antenna, considering the following:
 Locate the antenna in the road no closer than 18 inches and
no further than 30 inches from the manhole in which the
monitor is installed.
 Choose a location that is as flat as possible with stable base
material.
 If possible, select a location where the antenna would
experience minimal direct impact from road traffic.
 Make sure the location exists beyond the manhole’s iron
rim beneath the road surface. This will enable you to
access the manhole corbel when drilling the channel for the
antenna cable.

3.

Mark the location for the antenna installation, and then mark
the location to drill the corbel hole 2.5 to 3 inches back from
the edge of the antenna hole.

4.

Drill a hole from the marked corbel hole location in the road,
through the corbel, and into the manhole using the ½-inch by
36-inch hammer drill bit. This will serve as the channel for the
antenna cable running from the antenna to the monitor in the
manhole. Be careful to avoid any cables in the manhole, and
restart hole slightly to the right or left if mesh is encountered or
resistance occurs.

5.

Cut a 6-inch long by 1.25-inch wide by 0.75-inch deep hole in
the road using the non-rotating demolition hammer (in the
hammer only mode) with the chisel/grinder. This will serve as
the installation location for the antenna. The corbel hole should
travel under the center of this hole.
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6.
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Level the bottom of the hole using the demolition hammer with
the chisel and a bushing tool.

Hole running from antenna installation location to manhole

7.

Thoroughly clean out the hole for the antenna of all debris
using a shop vacuum with a brush.

8.

If the protective cap is not present on the connector at the end
of the antenna cable, clean the connector and tape it up with
rubber stretch tape to protect it from damage and debris while it
is traveling through the channel.

9.

Feed the antenna cable into the hole, through the channel, and
into the manhole. Smooth any rough edges where the cable
enters the corbel hole with the chisel or rubber stretch tape. In
addition, pack rubber stretch tape into cable hole to prevent
asphalt or sealer from entering the cable hole.

10. Remove the white release tape from the antenna element. Be
careful to avoid contacting the black rubber mastic material
with anything until the antenna is ready to be seated.
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11. Apply a piece of white release tape onto the top of the antenna,
and then seat the antenna into the bottom of the hole. Once the
antenna is firmly seated, remove the release tape.
12. Apply the asphalt on top of the antenna element. When using
asphalt, scoop the warm material into the hole and then pound
it in using a hammer. Place a piece of wood or metal between
the asphalt and the hammer to prevent the hammer from
sticking to the asphalt. Make sure the asphalt protrudes slightly
above the level of the road surface.
13. Sprinkle sand over the asphalt, and pound the sand lightly into
the surface. The sand must be used to ensure the asphalt
remains in the hole.

Antenna in cavity with patch

14. Coil the slack antenna cable and secure it away from the other
cables in the manhole. Slack enables the technicians to remove
the monitor from the manhole for maintenance or service
activities with the antenna cable still connected. Do not bundle
the antenna and sensor cable together! This can significantly
diminish antenna and sensor signal strength, disrupting
communications and limiting sensor accuracy.
Note: To prevent damage to the cable and antenna, do not
kink or bend the antenna cable when coiling.
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Installation with antenna cable coiled in manhole

15. Seal the space between the antenna cable and the corbel hole
with electrical duct seal or as required to prevent infiltration
into the manhole.
16. Remove the protective tape from the antenna cable connector
and attach the connector to the TELEMETRY/ANTENNA
connector port on top of the monitor.
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Top of monitor and antenna cable with connectors labeled

17. Wrap rubber stretch tape around the entire cable connection,
extending onto the cable approximately 2 inches beyond the
connection.

Cable connected to monitor with stretch tape properly applied
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Installing a Wireless Antenna in a Telephone
Pedestal Off the Road
Install a wireless antenna in a telephone pedestal located off the
road in the following way:
Note: Pedestal installation requires digging/trenching
activities. Therefore, do not use automated digging or
trenching equipment prior to identifying all underground
utilities through a utility location service. Hand digging is
permitted without prior identification.
1.

Gather the following parts, supplies, and tools:
 Wireless antenna and pedestal (ADS p/n 3800-0133)
 Portable electric drill with assorted bit sizes (include ½inch and 3/8-inch bits)
 8-inch cable ties
 Post hole digger
 Shovel
 Sledge hammer
 7/16-inch nut driver
 Corbel drill with a ½-inch by 36-inch bit
 Hacksaw
 Commercial asphalt cold patch compound
 Electrical duct seal
 Rubber stretch tape

2.

Determine the appropriate location to install the pedestal based
on the following factors.
 Locate the pedestal between 3 to 10 feet from the manhole
in which the monitor is installed.
 Evaluate the most suitable location for the service pedestal
and the most appropriate route for running the cable.
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Pedestal location and cable route evaluation criteria may
include issues such as the manhole location in relation to
the pedestal, existing landscape, utilities present, and
excavation costs.
 Notify a utility location service to locate and mark
underground utilities before digging or trenching with
automated equipment. Hand digging does not require prior
identification of utilities.
3.

Using a post hole digger or shovel, dig a hole at the designated
pedestal location approximately 4 inches deep and slightly
larger than the diameter of the pedestal base to accommodate
the base and the stake.

4.

Dig a trench at least 8 inches deep between the hole and the
manhole, tapering down from the pedestal location.

Hole, trench, and manhole

5.

Drill a hole at least a ½ inch in diameter in the corbel of the
manhole as close as possible to the bottom of the trench using a
corbel drill.

6.

Drive the stake of the pedestal into the ground at the designated
location until approximately 4 inches of the stake remain above
ground level. Be sure to avoid driving the stake in at an angle;
the pedestal should not be tilted once attached to the stake.
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Stake with 4 inches remaining above ground level

7.

Attach the base to the stake using the accompanying screws and
washers. The pre-drilled holes in the stake and base must line
up to secure them together.
Note: The stake mounts inside the pedestal base.

Securing the pedestal base to the stake
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Note: If you cannot get the stake down to the depth
required to align the holes together, use a hacksaw to
remove some of the length of the stake and drill new holes
with a 3/8-inch bit.
8.

Run the antenna cable through the bottom of the base into the
trench.

9.

Lay the cable in the trench, and run the cable through the predrilled hole in the corbel.

10. Coil the slack antenna cable and secure it away from the other
cables in the manhole. Slack enables the technicians to remove
the monitor from the manhole for maintenance or service
activities with the antenna cable still connected. Do not bundle
the antenna and sensor cables together! This can significantly
diminish antenna and sensor signal strength, disrupting
communications and limiting sensor accuracy.
Note: To prevent damage to the cable and antenna, do not
kink or bend the antenna cable when coiling.
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Installation with monitor and antenna cable in manhole

11. Seal the space between the antenna cable and the corbel hole
with electrical duct seal or as required to prevent infiltration
into the manhole.
12. Backfill the trench, the area surrounding the base, and the
inside of the base to ground level. Make sure you firmly pack
the backfill in the trench beneath the cable at the corbel hole.
This provides a firm surface to protect the cable from possible
crimping as the backfill accumulates and packs over the cable.

Backfill in trench protecting cable
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13. Install the dome onto the base by sliding the dome over the
bracket and base and then aligning the metal pins in the base
with the cutouts on the bottom edge of the dome. Once the
dome is seated in the cutouts, turn it to lock it into place.

Sliding the dome over the bracket and base

14. Connect the SMA connector at the end of the antenna cable to
the TELEMETRY/ANTENNA connector port on top of the
monitor.
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Top of monitor and antenna cable with connectors labeled

15. Wrap rubber stretch tape around the entire cable connection,
extending onto the cable approximately 2 inches beyond the
connection.

Cable connected to monitor with stretch tape properly applied

Warning: Never use the pedestal as an anchor for
equipment or personnel when conducting maintenance or
service operations at the site.

Mounting a Wireless Antenna on a Roof or Other
Protected Structure
This installation involves securing a wireless whip antenna with a
magnetic base (ADS p/n 3800-0128) to a roof or other protected
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magnetic structure. Roof or outdoor cabinet applications also
require a lightning protection device (ADS p/n 507180).
Mount the whip antenna in the following way:
Warning: Never place a magnetic mount antenna on top
of or near a office or field (laptop) computer. The strong
magnet in the antenna base will immediately corrupt the
computer’s hard drive.
1.

Identify an anchored or heavy steel surface at least 4 inches by
4 inches to serve as the grounding plate. Do not consider using
a manhole cover as a grounding plate to secure the antenna
unless it exists in a remote or fenced location.
Note: If the appropriate location for mounting the
antenna is a manhole cover, do not run the antenna cable
through a hole in the cover to avoid damage when
removing the cover.

2.

If the whip antenna is not attached to the magnetic base, screw
the antenna onto the base using any sealing washers or o-rings
included in the packaging.

3.

Seat the antenna base to the steel grounding plate surface
selected.

4.

(applies only to installations requiring lightning protection)
Install lightning protection according to the instructions
included with the lightning protection device.

5.

Run the antenna cable to the monitor location, and attach the
connector to the TELEMETRY/ANTENNA port on top of the
monitor.

6.

Wrap rubber stretch tape around the entire cable connection,
extending onto the cable approximately 2 inches beyond the
connection.
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Installing the SIM Card
FlowAlert monitors require a standard SIM card for wireless
communication. This card must be installed in the monitor before
communication can occur. The monitor uses SIM cards provisioned
by AT&T (ADS p/n 507181) for public static IP address operation.
Please contact ADS for specific information on procuring SIM
cards for use in the specific geographic area.
Install the SIM card in the monitor in the following way:
1.

Record the number from the SIM card (i.e., the IP address) on
the site report. This address is required for reconciling billing
and setting up the LIF in the Profile software. This IP address
is printed directly on the SIM card or on a label affixed to the
card.

Sample SIM card

2.

Loosen the bolts and remove the monitor lid (top) from the
aluminum canister.
Note: Removing the monitor lid during SIM card
installation increases the risk of damaging or introducing
debris or moisture to the circuit board. Make every effort
to prevent water, dirt, and debris from contacting the
monitor’s circuit board during SIM card installation.

3.

Lay the monitor top upside down with the plastic dust cover
protecting the printed circuit board facing upward.
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Dust cover over the printed circuit board on the underside of monitor top

4.

Disconnect the battery pack cable from the circuit board power
cable.

5.

Remove the four screws securing the dust cover, and remove
the cover.

Dust cover removed revealing the board
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Slide back the clip to the SIM card carrier on the circuit board
to unlock the carrier.

SIM card carrier (empty)

7.

Swing up the hinged clip to the carrier.

Clip open on SIM card carrier

8.

Gently insert the SIM card into the slot on the clip. Orient the
card so that the beveled corner of the card will align with the
beveled corner of the carrier when in place.
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Card inserted into open carrier clip

9.

Close the clip to the carrier, and slide the clip forward to lock
the SIM card into place.

SIM card secured in carrier clip

10. Replace the protective dust cover over the board, and replace
and tighten the screws securing the cover to the monitor top.
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11. Reconnect the battery pack cable to the circuit board power
cable.
12. Call the monitor through the wireless connection to verify
communication. Establishing communication requires setting
up the location through Profile and configuring the monitor
with the proper serial number and IP address.
13. Carefully replace the monitor lid onto the canister (without
pinching the battery pack/power cables), and torque down the
bolts securing the top to the enclosure to 35 inch pounds (+/– 5
inch pounds).
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Providing Telephone Service
Providing telephone service to the monitor involves the following
steps:


Running the telephone cable between the monitor and service
locations



Mounting the lightning protection module



Preparing the telephone cable



Wiring the telephone cable to the monitor



Wiring the telephone cable to the lightning protection module



Wiring the lightning protection module to the network interface
box
Warning: To avoid possible shock, make all connections
to the monitor before wiring to the lightning protection
module and the telephone company’s network interface
box.

Running the Telephone Cable Between the
Monitor and Service Locations
Warning: Always disconnect the telephone line at the
ONI/Network Interface while performing field wiring.
Dangerous voltages (100 VAC) are present when the line
is ringing. Connect to the telephone company line only
after all other wiring is complete.
The first step in establishing telephone service involves running the
telephone cable between the monitor and service locations.
However, before this can occur, the installer must evaluate the most
suitable location for the service pedestal and the most appropriate
route for running the cable. Pedestal location and cable route
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evaluation criteria may include issues such as the monitor's location
in relation to the closest service pole or pedestal, existing landscape,
utilities present, and excavation costs.
Note: For more information on determining the most
suitable pedestal location and cable route, consult your
ADS representative.
In addition, notify the local underground utilities locating service
concerning the desired pedestal location and cable route. Typically,
notification must occur 2 to 3 days before excavation activities are
scheduled to begin.
After finalizing the pedestal location and cable route and
completing the utility location, run the telephone cable between the
monitor location and the designated pedestal location in the
following way:
1.

Excavate a trench at least 12 inches deep from the designated
telephone service pedestal location to the monitor location.
Consult the local regulations to verify the required trench depth
for the area.

2.

Drill a hole in the corbel (structural foundation holding the
manhole cover) of the manhole large enough to accommodate
the diameter of ¾-inch electrical conduit plus an extra ½ inch.

3.

Run the telephone cable from the monitor location in the
manhole to the telephone service pedestal location through ¾inch electrical conduit. Consider the following parameters and
recommendations when running the cable:
 Use four-conductor Belden cable.
 Do not use plumbing conduit or water fittings.
 Run the telephone cable through the conduit one section at
a time as you lay the conduit in the trench and connect the
sections of conduit together. When necessary, use fish
tape to feed the telephone cable through the conduit.
 Provide enough slack in the cable at the manhole end to
allow removal of the monitor from the manhole during
service activities.
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 Provide approximately 12 to 15 inches of excess cabling at
the telephone service pedestal.
 Create a drip loop for any wires or cables that may be
subject to condensation to prevent moisture from entering
the electrical or telephone boxes.
 Extend the conduit through the hole in the corbel of the
manhole at the monitor location.
 Extend the conduit approximately 12 inches vertically out
of the trench (from the ground surface) at the designated
pedestal location.

Running conduit from the telephone service location to the manhole

4.

Use urethane foam to seal the space between the conduit and
the corbel to prevent infiltration into the manhole.

5.

Use urethane foam or a weatherhead to form a seal between the
telephone cable and conduit at each end of the conduit. This
will prevent sewer gases from entering the telephone service
pedestal, moisture from entering the conduit during a
surcharge, and inflow from entering the manhole.

6.

Backfill the trench, and restore the landscape as necessary.

7.

Install a service pedestal at the designated location based on the
manufacturer's instructions.

8.

Make sure the telephone company installs a network interface
box inside the pedestal.

9.

Make sure a ground rod (stake) is buried inside the pedestal.
This rod is critical to ensuring proper lightning protection. If
one does not exist, bury an 8-foot copper-coated steel rod
vertically into the ground inside the pedestal until it is
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completely submerged. Refer to the National Fire Protection
Association (NFPA) Standard 70 National Electrical Code
(NEC) Article 250 for detailed instructions on proper
grounding when an 8-foot vertical depth is not available.

Mounting the Lightning Protection Module
The next step in establishing telephone service is mounting the
lightning protection module to the service pedestal. Mount the
module as follows:
1.

Remove the front cover from the pedestal.

2.

Use the screws included with the lightning protection module to
mount the module on the pedestal at least 12 inches above the
ground surface and next to or 6 to 8 inches below the network
interface box.

Positioning of the lightning protection module and network interface box in
the pedestal
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Preparing the Telephone Cable
The next step in establishing telephone service is preparing the
telephone cable for connection to the lightning protection module.
Prepare the cable in the following way:
1.

Carefully strip about 3 inches of the external insulation from
each end of the telephone cable.

Stripping the external insulation from the telephone cable

2.

Remove the internal braiding, and separate the four insulated
wires.
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Separating the insulated wires

3.

Cut off both the orange and the orange/white-striped wires
down to the level of the external insulation. These wires will
not be used in this application.
Note: The wire colors referenced in this manual are based
on the telephone cable recommended for use in these
applications. However, the wires inside some telephone
cables may vary in color and number. Therefore, when the
actual wire colors and number differ from those designated
in this manual, connect the available wiring in reference to
ground, ring, and tip.

4.

Strip ½ inch of insulation from the remaining blue and
blue/white-striped wires.
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Stripping ½ inch of insulation from each wire

5.

At the pedestal end of the cable, fold over both exposed wires
(doubling the thickness). Insert each wire into a non-insulated
#10 ring terminal lug (22-18 gauge), and crimp the wires to the
lugs.

Wiring the Telephone Cable to the Monitor
After preparing the telephone cable, wire the telephone cable to the
monitor in the following way:
Note: Wiring the telephone cable to the monitor requires
an intermediate cable (External Power/Phone Cable - ADS
p/n 5000-0697) supplied by ADS when ordering a
FlowAlert monitor equipped for landline communication
1.

Unpack the FlowAlert phone cable (ADS p/n 5000-0697). This
is the same cable as the RainAlert II phone cable and the
FlowShark External Power Cable. The pigtail consists of two
bundled pairs: green/white and red/black. If these soldered
junctions must be modified or stripped to simplify the phone
junction process, keep the pairs together. Although they do not
require soldering, the green/white and red/black pairs must
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remain connected together securely when splicing to the phone
wire.
Connect the green/white and red/black pairs to the phone wires.
Use crimp-type or other outdoor-rated connection methods to
splice the monitor cable to the phone cable.

3.

Thoroughly wrap the completed connection with rubber tape.
Extend the tape up the cables beyond the connection to ensure
a good moisture seal and to reinforce the connection.

4.

Identify the communications port (TELEMETRY/
ANTENNA) on top of the monitor.
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US: 6KDMD06AHS1
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FCC ID: M2IGSM0108
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TELEMETRY/ANTENNA (communications) port on top of the monitor

5.

Seat, fasten, and secure the completed telephone cable onto the
communications port on the monitor. Tighten the connector in
a clockwise direction until it clicks. Verify that it is seated
correctly.
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Completed telephone cable connected to TELEMETRY/ANTENNA port on
monitor

Wiring the Telephone Cable to the Lightning
Protection Module
Next, wire the telephone cable to the lightning protection module
(ADS p/n 103313) in the following way:
1.

Open the front cover of the lighting protection module, and
remove the nuts, washers, and card from the posts inside the
module. Leave only the bottom-most nut on each post.

2.

Slice a hole in the grommet in the bottom of the module, and
run the telephone cable up through the grommet into the
module.

3.

Place the lugs for the following wires onto the designated posts,
and then re-place a washer and nut onto each post:
 Red wire to Telco network interface  Top left post (tip)
 Green wire to Telco network interface  Bottom left post
(ring)
 Blue wire from monitor  Top right post (tip)
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 Blue/white-striped wire from monitor  Bottom right post
(ring)

Lightning protection module wiring diagram

Note: Remember, the wire colors referenced in this
manual are based on the telephone cable ADS recommends
for these applications. However, the wires inside some
telephone cables may vary in color and number.
Therefore, when the actual wire colors and number differ
from those designated in this manual, connect the available
wiring in reference to ground, ring, and tip.
4.

Run the two wires (secured to the posts on the left) down and
out through the grommet in the bottom of the module.

5.

Place a washer onto each post, and replace the card.

6.

Securely tighten a washer and nut onto each post over the card.

7.

Make sure the ground wire (included with the lightning
protection module) is secured at the designated location on the
front left side of the card, and run the wire down through the
bottom grommet of the module.

8.

Close and secure the front cover of the module.
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9.

Cut ½ inch of insulation from the loose end of the black ground
wire running from the lightning protection module.

10. Clamp the exposed wire to the ground rod protruding from the
ground inside the pedestal or to the telephone company's
existing ground wire (when properly connected to the ground
rod).

Wiring the Lightning Protection Module to the
Network Interface Box
The final step in establishing telephone service is wiring the
lightning protection module to the telephone company’s network
interface box. Accomplish this task in the following way:
1.

Open the front cover of the telephone company's network
interface box, and temporarily disconnect the test plug.
Opening some network interface boxes may require a special
tool available only through the telephone company.

2.

Remove 3 inches of insulation from the lightning protection
module service cable to expose the four insulated wires.

3.

Cut off the black and yellow wires (running from the lightning
protection module) down to the level of the external insulation.

4.

Strip ½ inch of insulation from the green and red wires.

5.

Slice a hole in the rubber grommet in the bottom of the network
interface box (when necessary), and run the wires up through
the grommet into the box.

6.

Loosen the screws for tip and ring in the network interface box.
Wrap the following wires around the designated posts and then
re-tighten the screws until snug:
 Red wire  tip
 Green wire  ring
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Wiring diagram of a typical telephone company network interface box

Note: Since the colors inside some boxes vary, this
manual does not reference colored posts for connection.
The installer should connect the wires to the posts in
reference to ring and tip.
7.

Use urethane foam to seal the space between the telephone
cable coming from the manhole and the conduit. This prevents
sewer gases from traveling through the conduit from the
manhole into the pedestal. These gases could produce a
potentially explosive environment inside the service pedestal.

8.

Re-connect the test plug.

9.

Close and secure the cover of the network interface box.

4-34

ADS FlowAlert Manual

Complete wiring diagram

Communication
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Connecting to the Monitor in the Field
Communicating with the monitor on-site requires a direct serial
cable (ADS p/n 5000-0664) and a field computer running the
Profile software. The direct serial cable provides communication
between the user’s computer and the monitor without the need of
telemetry.
To use the cable for performing on-site communication, connect the
cable's 9-pin connector to the field computer's serial communication
port and the 5-pin connector to the monitor's DIRECT
COMM/EXT POWER communication port. Refer to the Profile
User's Guide (#950015**) for using the Profile software to
designate the appropriate local port for serial communication.

Connecting the field computer to the monitor in the field

Note: If your computer only has a USB port and no serial
port, use a USB to Serial adapter cable (and driver
software) to perform serial communications. Ensure that
the appropriate port for the USB adapter has been
designated in Profile (it will be different than the serial
port) before attempting communications. ADS

4-36

ADS FlowAlert Manual
recommends the following USB adapters: Dynex – model
DX-UBDB9, and Keyspan – model USA-19S.
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CHAPTER 5

Configuration and Activation

After installing the ADS® FlowAlert™ monitor, pressure depth
sensor, and float switch(es) and setting up communication, it is
necessary to configure and activate the monitor to begin taking flow
depth measurements and recording data at the monitor location.
This chapter contains general instructions on the following activities
concerning monitor configuration and activation:


Creating a monitor location



Creating an installation (pipe) table



Selecting and editing devices



Setting the communication parameters



Activating the monitor



Configuring power savings (optional)

This chapter also includes the procedure for running diagnostics on
the devices, collecting data from the monitor, and upgrading the
firmware (embedded software) in the monitor.
Refer to the Profile® User's Guide (#950015**) for more detailed
instructions on installing the software, collecting monitor data, and
configuring, activating, and confirming the monitor.
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Configuring the Monitor Location
To ensure the most accurate results for each monitor location, the
user must activate the FlowAlert monitor with the proper
configuration information to satisfy the specific monitoring needs of
the project and to reflect actual site conditions. The configuration
information includes critical details such as specific pipe
characteristics, location description, device assignment and
parameters, log rates, and other items relevant to the site and project
requirements.
The configuration information is stored in a Location Information
File (LIF) in the user’s local directory or network drive. Certain
elements of the LIF are saved to the monitor memory during
monitor activation.
This section includes instructions on performing the following
activities required for monitor configuration:


Creating a Monitor Location in the Profile database



Creating an Installation Table for the Monitor Location



Selecting and Editing Devices
Note: If remote (landline or wireless) communications
already have been established for the location, these
activities can be performed in cooperation between field
and office personnel. If remote communication is not
available, perform configuration and activation on-site
through direct communication with the monitor.

Launching the Profile Software
Before traveling to the field for installation, configuration, and
activation activities, install the Profile software on the field
computer.
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Once installed, launch the Profile software from an office or field
computer by selecting Start > Programs > ADS Corporation >
Profile from the Microsoft® Windows® start menu or doubleclicking on the Profile icon on the Windows desktop.

Profile icon on desktop

The Profile main screen displays.

Profile main screen

The left pane provides the capability to display all the levels and
current details for the selected database on a tree. These levels and
details are accessible by expanding and collapsing the entries on the
tree. Click on the plus symbol (+) next to an entry to display the
items contained under that level of the tree; click on the minus
symbol (-) next to an entry to collapse the items under that entry
level.
Select an entry or level name in the left pane to display the details
of that entry in the right pane of Profile.
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The toolbar provides access to various functions and tools in
Profile based on the item selected in the left or right pane.

Creating a Monitor Location
Creating a new location includes entering and setting up the
location information in the following way:
1.

Select the <All Locations> group located under the database
level.

2.

Select the Edit > New > Location option or click on the New
Location toolbar button.
A new location named New Location #1 is added to the <All
Locations> group and displays the Properties dialog.

Properties dialog for the new FlowAlert location
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3.

Enter the new Location Name. Do not duplicate more than the
first 7 characters for multiple monitors names.

4.

Enter the new location Description.

5.

Select FlowAlert from the Series drop-down list.

6.

Select the appropriate method of communication from the
Connect Using drop-down list.

7.

Enter the monitor location Telephone Number or the IP
Address for the wireless connection.
Note: When entering an IP Address, do not include
leading zeroes in the address. For example, an IP Address
of 166.219.008.063 should be entered as 166.219.8.63. If
leading zeroes are included in the address, monitor
communications will not be successful.
Note: To support emailing and text messaging for alarm
notification, the address of the monitor’s SIM card must
begin with 166.219.XXX.XXX. If the address begins with
other numbers, please contact ADS Client Services to
arrange for a replacement SIM card for the monitor.

8.

Enter the monitor Serial Number.

9.

Enter the number of hours difference between your location (or
the location of the computer on which the database resides) and
the location of the monitor in the Time Zone field. For a
monitor in a time zone earlier than the time zone in which you
are located, enter a minus sign before the number of hours
difference. For example, if you are in the Central time zone
and the monitor is located in the Mountain time zone, select -1
from this field.

10. Select the rate at which you want the monitor to log data from
the Normal drop-down list.
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Completed Properties dialog for monitor location

11. Click on the OK button to create a LIF for the location in the
database and exit the dialog.
The new monitor location with a single monitoring point is now
created and configured in the database.

Creating an Installation Table
Creating an installation table involves defining the size, shape, and
physical characteristics of the monitoring point. This table is
required for all FlowAlert installations, even those that do not
include a pressure depth sensor. Base all measurements for the
installation table on the incoming (upstream) pipe.
The user can create an installation table using the Installation
Generator in the Profile software in the following way:
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1.

Select the monitoring point for which you want to create the
installation.

Monitoring Point 1 selected from Location ADSTown_001

2.

Select Tools > Installation Generator from the main menu or
click on the Installation Generator toolbar button on the
Profile main screen.

Installation Generator toolbar button

The Create Installation – Introduction dialog in the wizard
displays.

Create Installation – Introduction dialog in the wizard

3.

Select the New radio button, and then click on the Next button.
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Create Installation – Installation dialog

4.

Select the Pipe radio button, and then click on the Next button.

Create Installation – Type dialog

5.

Select the type or shape of the pipe from the drop-down list,
and then click on the Next button.
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Create Installation – Dimension/Parameters dialog

6.

Enter the proper pipe dimensions in the corresponding fields,
and then click on the Next button.

Create Installation – Name dialog

7.

Enter an appropriate name for the installation in the text field,
and then click on the Next button.
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Create Installation – Summary dialog

8.

Review the installation table selection summary, and then click
on the Finish button. Click on the Back button to return to
previous dialogs to edit any of the existing selections.

Option to save pipe table dialog

9.

Click on the Yes button save the installation table to the Profile
database for the selected location.
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Installation Generator dialog

10. Select File > Exit to close the Installation Generator.

Selecting and Editing Devices
Select and edit the devices corresponding to the new monitor
location to log the desired data. Editing the devices involves setting
specific parameters to ensure the monitor and Profile properly
obtain and process the data. Perform the following steps to
properly select and edit devices:
1.

Select the location for selecting/editing devices from the
database.

2.

Expand the location contents (monitoring point and devices) by
selecting the expansion symbol corresponding to the location,
and then select Devices.
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Devices selected for ADSTown_001

3.

Select the Edit > Properties option or click on the Properties
toolbar button.

Properties toolbar button

The Edit Devices dialog displays the available devices and devices
selected by default for Monitoring Point 1.

Edit Devices dialog

4.

Select the checkboxes corresponding to the devices you want to
assign to the designated monitoring point from the Available
Devices selection box. A checkmark must display beside a
device in the Monitoring Point Devices section to ensure
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Profile includes the device in the LIF. Deselect the
checkboxes corresponding to the devices you want to remove
from association with the selected monitoring point from the
Available Devices section.
Note: Profile selects the Float device for the FlowAlert
monitor by default.
The selected devices display in the Monitoring Point Devices
section.
5.

Repeat steps 4 through 5 to assign devices to Monitoring Point
2, when applicable.

6.

As necessary, edit the parameters specific to each device in the
following way:
 Access the device parameters by selecting (highlighting)
the device you want to edit in the Monitoring Point
Devices section and then clicking on the Edit button.
 Refer to the following sections for details concerning the
specific device parameters.

7.

Once you have edited the devices as necessary, click on the
OK button to save the devices to the LIF.

Editing the Float Device(s)
Edit the parameters for each float switch device in the following
way, and then click on the OK button when complete:
Note: If the FlowAlert is supporting two float switches,
configure them both on the Edit Float Switch Parameters
dialog. Although the floats are configured on the same
dialog, each one represents an individual device.
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Edit Float Switch Parameters dialog


Enable Select this checkbox in the Float [1 and/or 2] section
to activate the options for the float you want to edit.



Alarm Select the kind of alarm you want to initiate when the
flow reaches the corresponding depth level.
Note: You may designate only one alarm for each device
when configuring the devices for a FlowAlert monitor.
However, the alarms can be distributed among the float
switches and the pressure depth sensor as applicable and
appropriate.



Debounce Use the arrows to designate the minimum amount
of time, following a change in state, the float must remain in a
new state to activate an alarm or indicate a return to normal.



Trip Point Enter the elevation at which the float changes
states.
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Editing the Pressure Device
Edit the pressure device in the following way, and then click on the
OK button when complete:

Edit Pressure Device Properties dialog


Serial Number Enter the serial number listed on the pressure
depth sensor.
Note: It is essential that you enter the pressure depth
sensor’s serial number and download the pressure
coefficients to ensure the monitor logs accurate pressure
depth data.



Coefficients Click on the Load button to browse to the
folder in the local directory containing the coefficients for the
pressure depth sensor (based on the sensor’s serial number).
These coefficients also can be entered manually. Download the
file containing the pressure coefficients to the local directory
from the ADS website in the following way:
 Access the ADS website at www.adsenv.com on the
Internet.
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 Select Environmental Services > Support > Client
Services.
 Click on the Download pressure coefficients… link.
 Right-click on the year in which the sensor was
manufactured, and select the Save Target As option.
 Rename the file to reflect the following format:
pressure.xx, where xx represents the last two digits of the
year in which the sensor was manufactured. You must
remove the .txt extension.
 Save the file to the appropriate location in the local file
system.


Pipe Height This field displays the pipe height at the monitor
location. This parameter is not editable from this location.



Physical Offset Enter the physical offset for the pressure
depth sensor based on the installation location. ADS
recommends measuring this distance manually during the
monitor installation or confirmation process. Profile defaults
to 0 inches.
 Pipe When the sensor is installed in a pipe, enter the
vertical distance from the bottom of the sensor to the
bottom center of the pipe.
 Manhole/Wet Well Wall When the sensor is mounted to
a manhole or wet well wall, enter the vertical distance from
the manhole invert (or bottom) to the nose of the sensor.



Depth Alarms – High Edit the device to ensure the
FlowAlert initiates a high depth alarm when a pressure depth
reading reaches or a exceeds a specified depth in the following
way:
 Enable Select this checkbox to activate the high depth
alarm options.
 Trigger Enter the pressure depth reading at or above
which you want the FlowAlert to initiate a high depth
alarm.
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 Return to Normal Enter the pressure depth reading at or
below which you want the FlowAlert to terminate alarming
conditions corresponding to a high depth alarm.


Depth Alarms – High High Edit the device to ensure the
FlowAlert initiates a high high depth alarm when a pressure
depth reading reaches or a exceeds a specified depth in the
following way:
 Enable Select this checkbox to activate the high high
depth alarm options.
 Trigger Enter the pressure depth reading at or above
which you want the FlowAlert to initiate a high high depth
alarm. ADS recommends that this value be at least 2
inches greater than the value entered for the high depth
trigger when it is in use.
 Return to Normal Enter the pressure depth reading at or
below which you want the FlowAlert to terminate alarming
conditions corresponding to a high high depth alarm.



Depth Alarms – Low Edit the device to ensure the
FlowAlert initiates a low depth alarm when a pressure depth
reading reaches or falls below a specified depth in the
following way:
 Enable Select this checkbox to activate the low depth
alarm options.
 Trigger Enter the pressure depth reading at or below
which you want the FlowAlert to initiate a low depth
alarm.
 Return to Normal Enter the pressure depth reading at or
above which you want the FlowAlert to terminate alarming
conditions corresponding to a low depth alarm.
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Editing the Notification Device

The FlowAlert monitor can provide alarm notification through
IntelliServe systems, email, and cellular phones with text
messaging (SMS) capability. These alarms represent High, High
High, and Low Depth alarms.
The FlowAlert also can check in daily and provide event
notification to an email address and cellular phone. Events concern
low battery voltage, power failure, and float and time errors.
Edit the notification device to setup alarm and/or event notification
in the following way, and click on the OK button when complete:


Alarm Enable Select this checkbox to activate the options for
configuring alarm notification to an IntelliServe system,
cellular phone, and/or email address.



IntelliServe Receipient Enter the IP address for the
IntelliServe system you want the FlowAlert monitor to notify
under alarm conditions.



Port This non-editable field represents the number of the port
through which wireless communication will occur (when
applicable). The current default and only applicable port is
2100.



Max Entries Enter the number of times within a sample
interval you would like the FlowAlert monitor to attempt to
establish communication following an event.



Diagnostics Enable Select this checkbox to enable the
FlowAlert monitor to send out event notification to a cellular
phone or email address.



Check In Enable Select this checkbox to ensure the
FlowAlert monitor checks in daily through an email or text
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message. The daily check-in provides the monitor name, date
and time, and battery voltage.


Check In Hour Select the time at which you want the
monitor to check in from the drop-down list.



Message Click on this button to display the Edit Alarm
Recipients dialog for entering alarm/event recipient email
addresses and cellular phone numbers.



Edit Alarm Recipients Enter the email address or cellular
phone number and select the corresponding communication
method for up to three recipients. To receive text messages,
enter both the area code and the phone number for the cellular
phone. Following is an example of the format to use for an
SMS number:
2561234567
Note: Text messages cannot be sent to landline numbers.
To receive email, enter the wireless provider’s SMS/mail
Gateway number and the recipient’s email address separated by
a colon. ADS only uses AT&T wireless service; therefore, all
emails should read in the following format:
+121:john.doe@adsenv.com

Editing the RSSI Device
The RSSI (Received Signal Strength Indication) device does not
require editing. This device corresponds to the signal strength for
wireless communication.
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Setting the Communication
Parameters
Setting the communication parameters involves designating the
modem, communication ports, and temperature, battery, and signal
thresholds to ensure proper communication, measurement, and
maintenance of the FlowAlert monitor. Modify the communication
parameters, as necessary, in the following way:
Note: Typically, the default settings should not require
modification.
1.

Select a monitor location from the Profile main screen, and
then select Tools > Diagnostics from the main menu or click
on the Diagnostics toolbar button.

Diagnostics toolbar button

The Monitor Diagnostics dialog displays.

Configuration and Activation 5-21

Monitor Diagnostics dialog

2.

Select Communication Parameters from the Functions dropdown list, and then click on the Perform button.

The Select Communication Parameters dialog displays.

Select Communication Parameters dialog
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3.

Select or enter the communication parameters as necessary:
 Modem Name Select the modem you want to use during
modem communication from the drop-down list. This list
should include all available modems on your computer.
 Modem Port Select the proper port for modem
communication from this drop-down list. This list should
include all available ports on your computer.
 Serial Port Select the proper port for serial
communication from this drop-down list. This list should
include all available ports on your computer.
 DMI Port (This parameter does not apply to the
FlowAlert monitor)
 Timeout Enter the number of seconds you want your
local computer to wait for a response from the monitor
once communication has been initiated.
 Retries Enter the number of times you want your local
PC to request data from the monitor following failed
attempts while the monitor is still on line.
 Low Temperature (This parameter does not apply to
the FlowAlert monitor)
 High Temperature (This parameter does not apply to
the FlowAlert monitor)
 Log Communications Select this checkbox to record
all communication activities with the monitor.
 Status On Connect Select this checkbox to view
details of the current state of the monitor when monitor
communications are established.
 Low Battery 1502, 1506, 3500, 4000 (These
parameters do not apply to the FlowAlert monitor)
 Low Modem Battery TCP/IP (This parameter does not
apply to the FlowAlert monitor)
 Low Signal Strength TCP/IP Enter the signal strength
(in dBm) below which you want Profile to provide
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notification for the wireless communication unit, when
applicable. ADS recommends using -95 dBm for the low
signal strength.
 Low Battery FlowShark, FlowShark IS, and IS
External (These parameters do not apply to the
FlowAlert monitor)
 Low Battery FlowAlert/RainAlert II Enter the voltage
below which you want Profile to provide notification for
FlowAlert and RainAlert II monitors. ADS recommends
leaving the default battery voltage unchanged.
Note: Notification of low battery voltage or signal
strength occurs during the data collection process, during
monitor activation, and when receiving TCP/IP
communication status. View the associated logs through
the Diagnostics tool and Log Viewer in the Profile
software.
4.

Click on the OK button.
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Activating the Monitor
After configuring the monitor, activate the monitor to initiate the
flow monitoring process based on the monitor configuration.
Monitor activation involves generating the activation data using the
Profile software, downloading this data to the monitor, and
initiating flow data measurement and logging. The activation data
includes the current monitor firmware (embedded software) and
relevant portions of the LIF and other configuration parameters
necessary to ensure monitoring activities reflect the specific site
conditions and project requirements. The monitor requires these
files and information to properly measure and record the flow.
Activating the monitor also tests communication between the user's
computer and the monitor. To test communication, connect to the
monitor on-site (using the Direct Connection cable) or have an
analyst call the monitor from any telephone or computer at a remote
location while a technician is on-site to verify that the monitor
modem responds. This also will verify the monitor telephone
number entered in Profile.
Monitor activation occurs through the Diagnostics tool in Profile.
Activate the monitor in the following way:
1.

Select the monitor location for activation from the Profile main
screen, and then click on the Diagnostics toolbar button.

The Diagnostics dialog displays.
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Diagnostics dialog

2.

Click on the Connect button to establish communication with
the monitor.

Profile initiates communication with the monitor and establishes a
connection.
3.

Select Activate from the Functions drop-down list, and then
click on the Perform button.

Profile displays the Activate Monitor dialog.

Activate Monitor dialog
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4.

(optional) Select the Clear data checkbox to ensure that all
data is removed from the monitor memory when activation
occurs. If you choose to implement this option ADS
recommends collecting all data from the monitor before
reactivating the monitor.

5.

Click on the OK button to activate the monitor.

Profile downloads the configuration and installation information,
activates the monitor, and begins logging data based on the
selected configuration.
6.

Click on the Disconnect button once activation is successful
(designated in the Results section) and complete.

The local computer disconnects from the monitor.
7.

Click on the Close button to exit the Monitor Diagnostics
dialog.
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Configuring the Power Savings
Parameters
Use the Power Saving function when you want to configure the
monitor to conserve battery power. Battery power is conserved by
powering down the wireless modem during specific hours of the
day. The monitor automatically powers up the wireless modem
each day between 11AM and 12PM to receive incoming calls.
However, you also can configure the modem for specific on/off
times for each day of the week.
Note: Alarms will be sent out even when the modem is in
Power Savings mode.
Complete the parameters of the Power Saving Configuration
window through the Diagnostics tool in Profile according to the
schedule best suited to your project. Configure the power saving
parameters for the monitor in the following way:
1.

Select the monitor location from the Profile main screen, and
then click on the Diagnostics toolbar button.

Diagnostics toolbar button

The Monitor Diagnostics dialog displays.
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Monitor Diagnostics dialog

2.

Click on the Connect button to establish communication with
the monitor.

Profile initiates communication with the monitor and establishes a
connection. Choose the Abort button prior to establishing a
connection to abort the communication attempt.
3.

Select Power Saving from the Functions drop-down list, and
then click on the Perform button to display the Power Saving
Configuration window.

Configuration and Activation 5-29

Power Saving Configuration window

4.

Choose a Global setting when you want all 7 days of the week
to be set to the same on or off mode.
 Set All On Choose this Global settings button to
configure all 7 days of the week to Always On or no
power saving periods. The wireless modem will be set for
uninterrupted power.
 Set All Off Choose this Global setting to configure all 7
days of the week to Always Off to facilitate maximum
battery savings. Wireless modem communications can be
performed only during the hour of 11 AM to 12 PM and
will be turned off all other hours of the day.
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Power Saving Configuration window

5.

Use the Mode, Start, and End fields to program each day of
the week uniquely for power savings. Repeat the instructions
for each day of the week you want to program and click on the
OK button to save and exit the Power Saving Configuration
window.
 Always On Choose this setting for uninterrupted
wireless modem communications and no power savings for
the selected day of the week.
 Always Off Choose this setting to allow wireless service
only during the hour of 11AM to 12 PM. This setting is
the maximum battery conservation mode for the selected
day of the week.
 Span On Choose this option to specify the span of time
you want the wireless modem to be available (powered)
during the selected day. If you choose this mode, specify
values in the Start and End fields for the beginning and
ending time for the span you want the wireless modem to
be active.
 Span Off Choose this option to specify the span of time
you want the wireless modem to be unavailable (powered
down) during the selected day. If you choose this mode,
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specify values in the Start and End fields for the
beginning and ending time for the wireless modem to be
powered down.
 Start This field is enabled when you choose Span On or
Span Off mode selections and allows you to specify the
beginning time for the selected span.
 End This field is enabled for Span On or Span Off mode
selections and allows you to specify the ending time for the
selected span.
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Running Device Diagnostics
Profile’s diagnostics tool enables the user to verify the proper
operation of the pressure depth sensor, obtain current readings and
status, adjust settings, and identify, diagnose, and troubleshoot
potential problems with pressure device. Run diagnostics for the
system devices in the following way:
1.

Select the monitor location for which you want to run
diagnostics on a device from the Profile main screen, and then
select Tools > Diagnostics or click on the Diagnostics toolbar
button.

Diagnostics toolbar button

The Monitor Diagnostics dialog displays.

Monitor Diagnostics dialog
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2.

Click on the Connect button to establish communication with
the monitor.

Profile initiates communication with the monitor and establishes a
connection.

Monitor Diagnostics dialog during communication with a monitor

3.

Run diagnostics on the pressure device in the following way:
 Select the Pressure 1 device from the Diagnose Device
drop-down list, and then click on the Diagnose button.

The Diagnostics dialog displays the current configuration
parameters stored in the LIF for the Pressure 1 device.
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Diagnostics dialog for the Pressure 1 device

 Click on the Fire button.
The Results section displays the current depth readings measured
by the pressure depth sensor.
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Diagnostics dialog for the Pressure 1 device following sensor firing

 Click on the Advanced button to view more detailed
diagnostic information.
 Verify the accuracy of the pressure depth readings, and
edit the configuration parameters as necessary.
Note: Refer to Editing the Pressure Device on page 5-13
for descriptions of the individual configuration parameters.
Save these modifications to the LIF in the monitor in the
following way:
 Click on the Store button to save any changes made in the
device parameters to the LIF in the database.
 Click on the Close button to exit the Pressure 1 device
dialog and return to the Monitor Diagnostics dialog.
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4.

Select Activate from the Functions drop-down list, and then
click on the Perform button. For more information on
activating a monitor, refer to Activating the Monitor on page 524.

5.

Click on the Disconnect button to discontinue communication
with monitor when finished running diagnostics on the system
devices.
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Collecting Data from the Monitor
The data collection function available through Diagnostics provides
enhanced features for viewing and analysis. Once the collection
process is complete, Profile displays pressure depth data in a
hydrograph format (when applicable).
For analysis purposes, the Diagnostics tool automatically processes
the data using Site DR (data review). This feature identifies issues
concerning data quality or missing information and offers
recommendations (when necessary) for conducting further review,
investigation, or analysis. Collect data from the monitor in the
following way:
Note: You can perform group and scheduled collects
using the Communications tool.
1.

Select the monitor location from which you want to collect
data, and then select Tools > Diagnostics from the main menu
or click on the Diagnostics toolbar button.

Diagnostics toolbar button

The Monitor Diagnostics dialog displays.
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Monitor Diagnostics dialog

2.

Click on the Connect button to establish communication with
the monitor.

Profile initiates communication with the monitor and establishes a
connection.
3.

Select Collect from the Functions drop-down list, and then
click on the Perform button.

Profile displays the Collect the Specified Data dialog.
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Collect the Specified Data dialog

4.

Designate the range of data you want to collect from the
monitor by editing the Start and End Time fields in the
Collect Information in the section. Edit these fields directly
by selecting the portion of the date or time stamp you want to
change and then entering the appropriate designation or using
the arrows to scroll up and down in the range. If you do not
edit the range, the start date and time automatically default to
the Auto Collect Start Date in the LIF.

5.

Click on the Collect button.

The Results section displays the status of the collect. Profile
collects all entity data from the monitor for the selected date/time
range and stores it in the currently selected database.
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Collect The Specified Data dialog indicating data collection was a success

6.

Click on the Next button.

The View Hydrograph – [location name] dialog displays the
collected data in hydrograph format.
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View Hydrograph – [location name] dialog

7.

Review the data on the hydrograph, and then click on the Next
button. Under optimal conditions, the depth data should reflect
a consistent diurnal pattern.

The Site DR Analysis – [location name] dialog displays the results
of the site data review analysis of the collected data and any
recommendations for resolving identified issues.
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Site DR Analysis – [location name] dialog

8.

Review any issues identified and the suggested actions, and
then click on the Finish button.

9.

Click on the Close button.

The Monitor Diagnostics dialog displays. The Results section
displays the recommendations from Site DR Analysis when
applicable.
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Monitor Diagnostics dialog displaying good results without
recommendations
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Upgrading the Monitor Firmware
Profile enables you to download updated firmware to a FlowAlert
monitor that may include new features and capabilities or
performance improvements and enhancements in functions such as
data processing, analysis, or communications.
Upgrading the firmware erases the monitor memory. Therefore,
you must collect the data from the monitor before updating the
firmware in the monitor to avoid losing the flow data stored in the
monitor memory. Refer to the Profile User’s Guide (#950015**)
for information on collecting data from the monitor. ADS also
requires that you reactivate the monitor after updating the firmware.
Upgrade the firmware in the FlowAlert monitor memory in the
following way:
1.

Select the monitor location for which you want to upgrade the
firmware, and select Tools > Diagnostics from the main menu
or click on the Diagnostics toolbar button.

Diagnostics toolbar button

The Monitor Diagnostics dialog displays.
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Monitor Diagnostics dialog

2.

Click on the Connect button to establish communication with
the monitor.

Profile initiates communication with the monitor and establishes a
connection.
3.

Select Update Firmware from the Functions drop-down list,
and then click on the Perform button.

The Form Firmware Download dialog displays.
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The Form Firmware Download dialog

4.

Click on the Browse button corresponding to DSP file to locate
and designate the DSP file applicable to the firmware
download. This program file represents the firmware
containing the updated code for data processing activities. An
example filename for this kind of file could be FAdsp600.biw.

5.

Click on the OK button.

Profile downloads the new firmware to the monitor.
6.

Select Activate from the Functions drop-down list, and then
click on the Perform button.

Profile activates the monitor with the updated firmware.
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Viewing Diagnostic and Data Logs
Profile generates detailed logs for many activities performed
through Diagnostics, such as monitor activation, data collection,
and firmware downloading. These logs are available immediately
following the activity and for future access to historical information.
1.

Select the monitor location for which you want to run
diagnostics on a device from the Profile main screen, and then
click on the Diagnostics toolbar button.

Diagnostics toolbar button

The Monitor Diagnostics dialog displays.

Monitor Diagnostics dialog

2.

Select Logs from the Functions drop-down list.

3.

Click on the Perform button.
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The View Logs dialog displays.

View Logs dialog

4.

Select the type of log you want to view from the Log Type
drop-down list.

The Logs section displays all logs available for the selected
location and log type.
5.

Select the specific log you want to view, and click on the View
button.

The View Logs dialog displays the logs available for viewing
corresponding to the selected log type.
6.

(optional) Click on the Print button to print the log file
contents.
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CHAPTER 6

Monitor Installation

After installing the sensors and establishing communications, install
the ADS® FlowAlert monitor in the manhole. The monitor may
mount inside the manhole by an aluminum mounting bracket
attached to the monitor and bolted to the manhole wall or rim. The
monitor also can mount directly to a manhole ladder rung by a rung
mount hanging bracket attached to the monitor. The following
procedures for monitor installation apply to most sites. However,
because manholes differ in many ways, some sites may require the
installer to implement slight modifications to the standard
installation technique.
Before installing the monitor at the site, activate the monitor to
verify that the monitor is configured correctly for the application
and that the battery pack (or external power) is operating at an
adequate voltage. Make any necessary changes to the configuration
before mounting the unit. Refer to Chapter 7, Maintenance and
Troubleshooting, for information on replacing the battery pack, if
necessary.
Warning: Using a battery-powered, wireless monitor
without connecting an antenna will significantly decrease
the life of the battery pack.
Note: Manhole and sewer system work involves confined
space entry and is inherently dangerous. Therefore,
installers and technicians must comply with all federal,
state, and municipal regulations concerning confined space
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entry. ADS is not responsible for any injuries, damages,
claims, or liability resulting directly or indirectly from the
use of this installation guide or the installation of any ADS
equipment.

Monitor Installation
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Mounting the Monitor to the Manhole
Wall
Mount the monitor to the manhole wall in the following way:
1.

Determine the appropriate location to mount the monitor
handle (i.e., bracket) (ADS p/n I40-0003/9) to the manhole
wall. This mounting bracket will connect to the welded flange
on the monitor housing. Consider the following when selecting
the proper location:
 Select a location that will allow you to remove the monitor
easily during service visits using the mounting bracket.
 Select a location that provides only a minimal potential for
the monitor to experience surcharge conditions.
 Select a location that will prevent the manhole lid from
potentially damaging the monitor during removal or when
rotating in the opening.
 Select a location that will allow personnel to enter/exit the
manhole without removing the monitor.

2.

Hold the top end of the mounting bracket against the manhole
wall, and mark the location for the mounting hole through the
keyhole in the bracket.

3.

Drill a hole 2½ inches deep at the mark, and install a 3/8-inch x
3-inch anchor bolt in the hole.
Note: Make sure all anchor bolts, studs, nuts, and
washers used in mounting the monitor are stainless steel.

4.

Twist a nut onto the anchor bolt, but do not tighten it down.
Leave enough space between the nut and the wall for the
thickness of the mounting bracket.

5.

Mount the bottom of the bracket onto the monitor flange with
two 3/8-inch x 1-inch hex bolts, 3/8 – 16 hex nuts, and 3/8-inch
washers.
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Bolting the mounting bracket to the flange welded to the monitor

6.

Carefully lower the monitor into the manhole, and place the
keyhole of the mounting bracket over the anchor bolt.
Note: ADS strongly recommends attaching a security line
to the monitor before lowering it into the manhole to
prevent the monitor from accidentally dropping down the
manhole during installation.

7.

Tighten and secure the bolt against the mounting bracket.

Monitor Installation
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Monitor installed in the manhole

8.

Neatly coil and secure the excess sensor and telephone cables
in the manhole to simplify future monitor service activities.
Secure the cables to plastic anchors or ¼-inch x 2 ¼-inch
anchor bolts using 14-inch cable ties.
Note: Be careful to avoid damaging the sensor cables
during installation activities. Even small pinholes in the
cable can cause a sensor to malfunction or fail.
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Mounting the Monitor to the Manhole
Rim
Mount the monitor to the manhole rim in the following way:
1.

Determine the appropriate location to mount the monitor
handle (i.e., bracket) (ADS p/n I40-0003/9) to the inside of the
iron manhole rim. This mounting bracket will connect to the
welded flange on the monitor housing. Consider the following
when selecting the proper location:
 Select a location that will allow you to remove the monitor
easily during service visits using the mounting bracket.
 Select a location that provides only a minimal potential for
the monitor to experience surcharge conditions.
 Select a location that will prevent the manhole lid from
potentially damaging the monitor during removal or when
rotating in the opening.
 Select a location that will allow personnel to enter/exit the
manhole without removing the monitor.

2.

Hold the keyhole at the top end of the bracket against the lower
inner rim of the manhole, and mark the location for the
stainless steal stud through the keyhole in the bracket. Make
sure there will be enough room to lift the bracket up and over
the stud when installed.

3.

Drill a hole(s) into the manhole rim 1 inch deep using a 5/16inch carbide-tipped drill bit.
Note: Consider starting the hole using smaller bits to
make pilot holes and increasing up to a 5/16-inch bit. In
addition, spray cutting oil or another lubricant into the hole
while drilling and tapping.

Monitor Installation
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Drilling the hole in the manhole rim

4.

Use a 3/8-inch x 16 threads-per-inch tap to cut threads in the
hole. Twist the tap clockwise ¾ turn, and then back out ½ turn
before continuing deeper.

Using the tap to thread the hole
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5.

Chase the threading action at intervals to clear the metal debris
by backing the tap almost completely out of the hole and then
screwing it back into the hole. Lubricate the hole between
threading.

6.

Place two 3/8 – 16 hex nuts (with a 3/8-inch washer in
between) onto one end of a 3/8- × 2-inch stud.

Placing two nuts and a washer onto the stud

7.

Using two wrenches, turn the inner nut counter-clockwise and
the outer nut clockwise simultaneously to bind the two nuts
together on the stud.

Monitor Installation
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Binding the nuts together with the washer in between

8.

Install the stud into the tapped hole using the outer nut to
engage the wrench. Continue turning the nut clockwise until
the stud is seated at least ¾ inch deep in the hole.

Installing the stud into the hole in the manhole rim

9.

Separate the nuts, and turn the inner nut until it is flush against
the rim.

10. Slide the washer against the inner nut, and turn the outer nut
toward the edge of the stud.
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Positioning the nuts on the stud to receive the mounting bracket

11. Mount the bottom of the mounting bracket onto the monitor
flange with two 3/8-inch x 1-inch hex bolts, 3/8 – 16 nex nuts,
and 3/8-inch washers. It may be necessary to drill new holes in
the flange.

Bolting the mounting bracket to the flange welded to the monitor

12. Carefully lower the monitor into the manhole, and place the
keyhole in the bracket over the outer nut on the stud.

Monitor Installation
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Note: ADS strongly recommends attaching a security line
to the monitor before lowering it into the manhole to
prevent the monitor from accidentally dropping down the
manhole during installation.
13. Slide the bracket against the inner nut and washer, and tighten
and secure the outer nut against the bracket.
14. Neatly coil and secure the excess sensor and telephone cables
in the manhole to simplify future monitor service activities.
Secure the cables to plastic anchors or ¼-inch x 2 ¼-inch
anchor bolts using 14-inch cable ties.
Note: Be careful to avoid damaging the sensor cables
during installation activities. Even small pinholes in the
cable can cause a sensor to malfunction or fail.
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Mounting the Monitor to a Manhole
Ladder Rung
ADS offers a rung mount hanging bracket with a hook (ADS p/n
106222A) to mount the monitor to a manhole ladder rung. Mount
the monitor to a rung in the following way:
Note: ADS strongly recommends attaching a security line
to the monitor before lowering it into the manhole for
hanging.
1.

Verify that the rung to which you want to secure the monitor
can support the weight of the monitor.

2.

Secure the monitor to a safety line.

3.

Slowly and carefully lower the monitor into the manhole,
preventing it from striking the manhole wall or other structures
or equipment in the manhole.

4.

Open the loop end of the rung mount hanging bracket, and slip
it over the top ladder rung.

5.

Close the loop end of the hanging bracket and secure it.

Monitor Installation
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Monitor secured to a ladder rung using a rung mount hanging bracket

6.

Once the monitor is hanging securely in place, remove the
safety line.

7.

Neatly coil any slack in the cables into loops, and use a cable
tie to secure the loops together. Lower the loops into the
manhole, and secure them to a ladder rung using another cable
tie.
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CHAPTER 7

Maintenance and
Troubleshooting

While the ADS FlowAlert monitor, pressure depth sensor, and
float switches are designed for dependability and durability, all
electronic devices are vulnerable to wear, malfunction, or failure,
particularly in a harsh sewer environment. However, many system
problems can be avoided altogether by performing routine
maintenance and inspections. The design of the monitor enables the
user to perform general diagnostics and troubleshooting to prevent,
isolate, and correct many problems easily. These serve to minimize
unnecessary monitor downtime and data loss.
This chapter provides routine maintenance instructions as well as
general diagnostic and troubleshooting guidelines for isolating and
correcting monitoring system problems.
Warning: Remove the monitor from the manhole before
replacing the battery packs or performing service activities
which may involve disconnecting cables from the monitor.
In addition, disconnect telephone service at the network
interface box before disconnecting cables from the monitor
lid. These activities help prevent possible shock or injury
to personnel as well as damage to the equipment during
service visits at the monitor location.
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Maintaining the System Components
The FlowAlert monitor, pressure depth sensor, and float switches
should receive routine on-site inspections and remote confidence
checks to maintain the equipment in optimal working condition,
minimize monitor downtime, and prevent possible data loss.
ADS recommends performing these inspections following initial
system installation, during site visits, and on a scheduled interval
(i.e., quarterly or during battery pack replacement).
Note: The only service or maintenance activity ADS
permits within the monitor chassis is battery pack
replacement. Therefore, please do not handle, alter,
modify, remove, or replace any other components inside
the monitor. This may void the monitor warranty
agreement.

Gathering Replacement Parts and Supplies
Gather the following replacement parts and supplies for performing
routine maintenance:


Dryer tube for the pressure depth sensor



Battery pack



Pressure depth sensor



Float Switch(es)



Soft bristle brush



Paper towels



Compressed air



Flat head screwdriver and assorted wrenches (including torque
wrench)
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Inspecting the Monitor
Perform the following inspections during site visits or from a
remote location (when applicable):


Inspect the monitor mounting bracket to verify that the bracket
and bolts are free of heavy corrosion and the bolts are tightened
and secure.



Verify that the four bolts holding the monitor together are snug,
and tighten any loose bolts.



Verify that the monitor is mounted securely in the manhole.



Inspect the monitor for general integrity. Verify that nothing
more than surface corrosion is present and that the monitor has
no obvious mechanical defects. Replace the monitor if
necessary.



Perform monitor data confirmations. These should occur from
a remote location when wireless or telephone communication is
available. You also can perform these locally through a serial
connection.



Review the applicable logs in Profile to verify the status of
the monitor clock, communications, firmware, battery pack,
and temperatures.



Clean the monitor, sensor, and float regularly with a soft bristle
brush and paper towels. However, do not use detergent!



Make sure all connector ports on the monitor top are dry. Use
compressed air or paper towels to dry out wet or damp
connectors.

Confirming the Monitor
Confirm the accuracy of the pressure depth sensor through the
monitor on a regular basis. Confirmation involves comparing
manually-measured depth of flow readings to the monitor's
readings. This process also verifies sensor parameters. Refer to the
Profile User's Guide (#950015**) for detailed information on
performing confirmation procedures.
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Obtaining Diagnostic Codes from the Monitor
The FlowAlert monitor enables you to view diagnostic information
from the monitor instantly through an LED window, labeled
STATUS/DISPLAY, located on the monitor top. This information
represents specific codes corresponding to the wireless
communication signal strength (when applicable) and the monitor’s
battery voltage and IP address (when applicable). It is particularly
helpful during site investigation and system installation to ensure an
adequate and consistent signal strength, to test communications, and
to verify the monitor IP address.
Activate the diagnostic code sequence by disconnecting and
reconnecting the connector attached to the FLOATS/PRESSURE
port on the top of the monitor in less than one second. The code
will begin to display immediately. Therefore, make sure the LED
window is in clear view before initiating the code.
Note: Always verify that the LED window is blank before
attempting to activate the code.
Upon diagnostic code activation, interpret the diagnostic codes in
succession in the following way. The LED window displays only
one number/character at a time:


“ads” indicates code initiation



bbbbb is followed by the battery voltage to two decimal places



rrrrr is followed by the wireless communication signal strength
(ranging from -51 to -112 dBs; 99 indicates no signal is
available)



nnnnn is followed by the monitor IP address

Checking the Monitor Battery Pack Voltage
Check the battery voltage through the LED window on the monitor
or using Profile before installing the monitor. ADS also
recommends verifying the battery voltage after collecting data.
Replace the battery pack as soon as possible whenever the voltage
reads below 4.5 volts or Profile provides a Low battery status.
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Warning: Batteries reading below 4.5 volts may prevent
communication with and data collection from the monitor.
Check the current battery voltage in the monitor using the
Diagnostics tool in Profile in the following way:
1.

From the Profile software main screen, select the monitor and
then click on the Diagnostics toolbar button (or select Tools >
Diagnostics from the main menu).

2.

On the Diagnostics dialog, click on the Connect button to
establish communication with the monitor.

3.

Once communication is established, select Monitor Status
from the Functions drop-down list and then click on the
Perform button.

The Print Preview dialog displays the current system information,
including the monitor battery voltage, in printable format. Select
the Print button to print the report contents.

Print preview dialog (battery pack voltage displays under Voltage)
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Replacing the Monitor Battery Pack
When necessary, replace the battery pack in the monitor in the
following way:
Warning: During rainy or snowy conditions, disconnect
the cables from the monitor and move to a dry area before
changing the battery pack. The circuit board is not
completely sealed and must be kept dry. If the monitor is
moved indoors from a cold, outdoor environment, wait for
the entire chassis (inside and out) to acclimate to the inside
temperature before changing the battery. Failure to do so
will result in condensation damage to the boards.
Note: Be careful to avoid damaging or pinching the
battery cable between the monitor top and the enclosure
when replacing the battery pack.
Note: The only service or maintenance activity ADS
permits within the monitor enclosure is battery pack
replacement. Therefore, please do not handle, alter,
modify, remove, or replace any other components inside
the monitor. This may void the monitor warranty
agreement.
1.

Collect the data from the monitor.

2.

Loosen bolts and remove the monitor lid from the aluminum
canister.
Note: Removing the monitor lid during battery pack
replacement increases the risk of damaging or introducing
debris or moisture to the circuit board. Make every effort
to prevent water, dirt, and debris from contacting the
monitor's circuit board during routine maintenance.

3.

Disconnect the battery pack cable from the circuit board power
cable.

4.

Carefully remove the battery pack from the canister using the
attached white strap.
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Battery pack seated in monitor (lift out using white strap)

5.

Remove the foam insert located between the strap and the
battery pack, and place it in the same location on the new
battery pack.
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Battery pack with foam insert disconnected from monitor

6.

Place the new battery pack into the enclosure without pinching
the cables, and carefully push the excess cabling between the
battery pack and the enclosure.

7.

Connect the new battery pack to the circuit board power cable.

8.

Call the monitor or connect to the monitor on site using a serial
communication cable to verify communication.

9.

Carefully replace the monitor lid onto the enclosure (without
pinching the battery cables), and torque down the bolts
securing the chassis to the enclosure to 35 inch pounds (+/- 5
inch pounds).

Maintenance and Troubleshooting
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Checking the Sensor and Float Switch
Perform the following sensor inspections and service during regular
site visits:


Verify that the installation ring or band is secure and clear of
debris.



Scrub the pressure depth sensor with a soft bristle brush.



Confirm that the pressure depth sensor cable is securely
fastened and free of debris, cuts, and breaks that may affect
performance. Replace a sensor that exhibits a damaged cable.



Inspect the float switch housing for heavy grease or other
debris. Remove or wipe off any debris using a paper towel.
ADS recommends inspecting the float switch following an
event in which the float contacts the flow to ensure no debris
remains on the float.



Inspect cable ties and other plastic fasteners for signs of
degradation, such as cracks, and replace as necessary.

Inspecting and Replacing the Pressure Depth
Sensor Dryer Tube
Inspect and replace the pressure depth sensor's dryer tube on a
regular basis. Verify the desiccant in the pressure depth sensor’s
dryer tube is still blue. Pink desiccant indicates that it will no
longer absorb moisture. If it appears pink upon inspection, replace
the dryer tube immediately in the following way:
1.

Clip the cable ties securing the dryer tube to the monitor.

2.

Cut the clear flexible tubing running from the dryer tube to the
pressure depth sensor connector at the location close to the
brass barbed fitting on the dryer tube.

3.

Place the dryer tube with the used desiccant aside, but do not
discard.
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4.

Attach a new dryer tube to the pressure depth sensor by
inserting the brass barbed fitting into the open end of the plastic
tubing running from the sensor connector. Make sure the
tubing seats firmly against the fitting to prevent air or moisture
transfer.

Inserting the brass barbed fitting into the tube

5.

Secure the new dryer tube to the monitor.

6.

Remove the black end cap before reinstalling the monitor in the
manhole.
Note: Replacing the dryer tube quarterly may be
sufficient; however, replace it more frequently when
necessary.

Checking Communication Devices
Inspect the following communication devices during site visits:


Antenna Cable Check the cable for damage, kinks, or breaks
in the cable. Make sure the connector between the antenna
cable and the monitor is dry and sealed with rubber stretch
tape.
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Lightning Protection Module Check the lightning
protection module for lightning strikes (visible arcing),
damaged or poor connections, or corrosion. Replace a burned
out module, and repair any bad or corroded connections in the
wiring.



Network Interface Box If any problems exist with the
network interface box, check the connectors to ensure that the
cable entries are tight and waterproof. If this does not resolve
the problem, contact the telephone company.
Note: Make sure both the lightning protection module
and network interface box are still waterproof.
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Troubleshooting
The FlowAlert monitoring system contains several different
components that perform many different functions. Since a
malfunctioning component increases the risk of losing data,
isolating the part containing the problem quickly is essential to
performing troubleshooting activities efficiently. Minimizing
monitor downtime is critical.
Consider the following when trying to isolate the component or
subsystem exhibiting the problem:


Problems affecting only one of the subsystems are usually
caused by one subsystem alone. The problem may exist in the
board, sensor, float switch, or cabling.



Problems affecting more than one subsystem usually can be
traced to a problem with the processor, power source, or
communication lines. Problems in one subsystem can create
problems in other subsystems when the power source or
communication lines are faulty.



Problems with communication lines, clock readings, time
stamps, and data storage intervals usually arise from faulty
processors, incorrect information entered on the user's PC, or
low batteries.



Failures occurring outside a connector (i.e., between a
connector and the field input or output device) may arise from
problems with the field unit or component cabling. Failures
occurring on the inside (i.e., between a connector and the
printed circuit board) may arise from problems with the board
or its cabling.
Note: If possible, collect all monitor data prior to
swapping a sensor/float switch or troubleshooting a
monitor to prevent possible data loss. Swapping a sensor,
float switch, or battery pack does not result in stored data
loss. In addition, remove the monitor from the manhole
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before disconnecting cables from the monitor to avoid
possible hazards.
Some problems that occur will not require a site visit, such as
incorrect equipment identification numbers or other system
parameters the user can re-enter on the local PC. However, some
problems will require a site visit. When this is necessary, inform
the analyst any time a field crew is enroute to a monitor location to
troubleshoot problems so that the analyst can attempt to collect the
monitor data before they arrive. If the problem is a faulty monitor
and the analyst cannot collect the data remotely, replace the monitor
and deliver the faulty monitor to the office so the analyst can
attempt to collect the data directly. If the analyst is still unable to
collect the data from the monitor, send it to ADS for repair.
This chapter provides general guidelines for troubleshooting and
correcting problems with the FlowAlert monitor, the pressure depth
sensor, or the float switch(s).

General Monitor Problems
The following tables contain general techniques for troubleshooting
the ADS FlowAlert monitor.
Warning: Contact your regional ADS representative for
further diagnosis before replacing a monitor.

Problem

Time stamp on the collected data is incorrect.

Possible
Causes

PC clock may read incorrect time.

Possible
Solutions

Verify the time on the PC clock and correct if necessary.

Monitor clock may be faulty.

Reactivate the monitor to enable the clock.
Collect the data from the monitor and replace monitor if
defective.
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Problem

Time on the monitor clock is incorrect.

Possible
Causes

Monitor clock may be faulty.

Possible
Solutions

Verify the time on the PC clock and correct if
necessary.

PC clock may read incorrect time.

Reactivate the monitor to enable the clock.
Collect the data from the monitor and replace monitor if
defective.

Problem

You receive a Device Time Out message in Profile.

Possible
Cause

Circuit board may be faulty.

Possible
Solutions

Re-attempt communication with monitor.
Replace the monitor if defective.
Contact your regional ADS representative.

Problem

Gap exists within the collected data.

Possible
Cause

Monitor time may be incorrect.

Possible
Solutions

Check monitor time, and reset clock if necessary.

Monitor firmware or variable file may be corrupt.

Attempt to collect data within the gap.
Contact your regional ADS representative.
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Problem

Data is missing at the beginning or end of the date
range following data collection.

Possible
Causes

Monitor activation may have failed.
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Monitor time may be incorrect.
Monitor’s firmware or variable file may be corrupt.

Possible
Solutions

Verify whether the monitor has been activated, and
activate if necessary.
Check monitor time, and reset clock if necessary.
Contact your regional ADS representative.

Problem

An I/O error message displays when communicating
with the monitor.

Possible
Cause

Circuit board may be faulty.

Possible
Solutions

Re-attempt communication with the monitor.
Replace the monitor if defective.
Contact your regional ADS representative.
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General Communication Problems
The following tables contain general techniques for troubleshooting
communication problems.
Problem

Monitor does not answer a telephone call.

Possible
Causes

Telephone connection at monitor may be damaged,
loose, or leaking.
Telephone cable may be noisy, damaged, or dead.
Lightning protection module may be damaged.
Battery pack(s) may be dead or below minimum voltage
requirement (4.5 volts).
Monitor may be defective.
Modem in monitor may be defective.
Modem in office or field computer may be defective.
Telephone service may not be working.

Possible
Solutions

Make sure phone cable connection at monitor base is
secure and dry.
Check telephone cable for damage.
Use voltmeter to check voltage on telephone cable and
at lightning protection module. Voltage should be
approximately 48 Vdc on hook.
Replace 7.5-volt battery pack if below 4.5 volts.
Attempt to direct connect to monitor.
Contact telephone company for repair if noise, no tone,
or constant busy signal occurs at network interface box
or if service does not seem to be working.
Replace the monitor.

Maintenance and Troubleshooting

Problem

Monitor does not answer through wireless
communication.

Possible
Causes

Signal strength to the modem may be insufficient.
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Battery pack may be dead or below minimum voltage
requirement (4.5 volts).
Monitor may be defective.
Modem in monitor may be defective.
Antenna or cable may be damaged.
Internet connection in office or field computer may be
down.
Wireless carrier may have problems.
Port 2100 may be blocked by IT department.

Possible
Solutions

Direct connect to monitor on site, and request the signal
strength. If the signal strength falls between -51 and 95, communication should be available. If it reads
below -95, relocate the antenna. If relocation is not an
option, install a land line or perform all communications
on-site.
Replace the 7.5-volt battery pack if below 4.5 volts.
Replace the monitor.
Replace antenna/cable.
Restore Internet connection.
Check for AT&T outage.
Restore/establish permission to pass TCP/IP traffic via
Port 2100.

7-18

ADS FlowAlert Manual

Problem

Busy signal occurs when calling the monitor using a
landline.

Possible
Causes

Someone else may be communicating with monitor.
Monitor may be calling out an alarm.
Telephone cable may be damaged.
Lightning protection module may be damaged.
Telephone cable may have shorted.
Modem in monitor may be damaged.
Telephone service may not be working.

Possible
Solutions

Wait a few minutes, and attempt to communicate with
monitor again.
Connect at the site using the serial cable, and try to
communicate with monitor.
Use voltmeter to check voltage on telephone cable.
Voltage should be approximately 48 Vdc on hook. If it
is not, disconnect phone line at the lightning protection
module and check the voltage at the network interface
box.
Make sure telephone cable is not damaged or severed,
and repair or replace cable if necessary.
Check telephone connector for moisture.
Contact the telephone company to report service is not
working.
Replace the monitor.

Maintenance and Troubleshooting
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Problem

Monitor establishes a connection, but does not respond
to any message.

Possible
Causes

Cabling may be loose.
Lightning protection module may be damaged.
Modem in monitor may be faulty.

Possible
Solutions

Listen for noise at the site using a field phone. If noise is
present, inspect the wirings and replace wiring if
necessary.
Replace the lightning protection module.
Contact telephone company.
Collect the data from the monitor on site using the serial
cable, and replace monitor if defective.
Contact your regional ADS representative.

Problem

Monitor does not deliver alarms through emailing or text
messaging.

Possible
Causes

SIM card is missing or improperly installed.
Text message or email address entered for alarm
delivery is incorrect.
SIM card address is not valid.
AT&T account has not been activated or set up
correctly.

Possible
Solutions

Verify the presence and proper installation of the SIM
card.
Verify the correct cryout address for alarm notification
through emailing or text messaging.
Verify the SIM card address begins with
166.219.XXX.XXX and does not include leading zeroes.
Verify that AT&T activated and correctly set up account.
Contact your regional ADS representative.
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General Pressure Depth Problems
The following tables contain general techniques for troubleshooting
pressure depth.
Warning: Contact your regional ADS representative for
further diagnosis before replacing a pressure depth sensor.

Problem

Pressure depth readings are consistently incorrect.

Possible
Causes

Coefficients may be incorrect.

Possible
Solutions

Retrieve or enter the correct coefficients, and reactivate
the monitor.

Pressure dryer tube may not be functioning properly.

Inspect color of desiccant in dry tube and replace the
dryer tube (if necessary).

Problem

Pressure depth readings are consistently off by up to 3
inches, but temperature readings are accurate.

Possible
Cause

Monitor may be configured with an incorrect pressure
sensor offset.

Possible
Solution

Re-measure pressure sensor physical offset and enter
correct value in Profile. Reactivate the monitor.
Enable Auto-Pressure Calibration feature in Profile to
calibrate the pressure sensor data to the ultrasonic data
during non-surcharge conditions.

Maintenance and Troubleshooting
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General Float Switch Problems
The following tables contain general techniques for troubleshooting
float switches.
Warning: Contact your regional ADS representative for
further diagnosis before replacing a float switch.

Problem

Float switch status is not consistent with pressure depth
readings.

Possible
Cause

Float switch may be unable to change position due to
obstruction or debris.
Float switch may be malfunctioning.

Possible
Solution

Inspect float switch in manhole for obstructions or debris
and make necessary modifications.
Replace float switch.

Problem

Float switch does not change status when flow depth
reaches high or high high depth status.

Possible
Cause

Float switch may be unable to change to open
(horizontal) position due to obstruction or debris.
Connector may not be properly engaged.
Float switch may be malfunctioning.

Possible
Solution

Inspect float switch in manhole for obstructions or debris
and make necessary modifications.
Inspect connection between float and monitor.
Replace float switch.
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Problem

Float switch does not change status when flow depth
recedes.

Possible
Cause

Float switch may be unable to return to closed (vertical)
position due to obstruction or debris.
Connector may not be properly engaged.
Float switch may be malfunctioning.

Possible
Solution

Inspect float switch in manhole for obstructions or debris
and make necessary modifications.
Inspect connection between float and monitor.
Replace float switch.

Problem

A float error occurs.

Possible
Cause

Connector may not be properly engaged (attached). An
error will not occur if two float switches are in use, but
only once the connector becomes disengaged.
Float switch may be malfunctioning.

Possible
Solution

Inspect connection between float and monitor.

Problem

The float state changes, but no alarm occurs.

Possible
Cause

Connector may not be properly engaged.

Possible
Solution

Replace float switch.

Float switch may be malfunctioning.
Inspect connection between float and monitor.
Replace float switch.
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APPENDIX A

Specifications

This appendix contains specifications for the ADS FlowAlert
monitor, printed circuit board/digital signal processor, pressure
depth sensor, float switch, and lightning protection module.

ADS FlowAlert Monitor (ADS p/n 6000FAL/FAW)
The following table contains the specifications for the FlowAlert
monitor.
Note: Currently, FlowAlert monitors are not intrinsically
safe.
Enclosure
Dimensions
Weight
Operating
Temperature

Cylindrical 0.13-inch (0.30 cm) thick seamless,
marine-grade aluminum with stainless steel hardware
11.5 inches long by 6.38 inches diameter
22 pounds (monitor with battery)
32° to 140° F (0° to 60° C)
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Internal Power

Landline: One ADS 7.5-volt 130 amp hour alkaline
battery pack (not rechargeable)
Wireless: One ADS 7.5-volt 130 amp hours alkaline
battery pack powering both the monitor and the
wireless modem; power to modem can be continuous
or managed via duty cycles for power saving

Waterproof

Submersible up to 10 feet

Battery Life

5-minute sample rate: 12 months
15-minute sample rate: 24 months
Note: Estimate based on performing weekly data
collects. Actual battery life may vary depending on
operating temperature and frequency of
communications, particulary when using wireless
communication.

Connectors
Inputs

U.S. MIL-C-26482 Series 1 Type, for environmental
sealing, with gold-plated contacts
Float switch/pressure depth sensor input
Serial/direct connection/external power input
Communication – telemetry or antenna (GPRS
wireless)
Air pressure valve (for testing purposes only)

Specifications
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Printed Circuit Board (ADS p/n 6000-0001)
The following table contains the specifications for the printed
circuit board.
Processor

Texas Instruments VC33 DSP (Digital Signal
Processor)

Functions

Performs and processes all requests for sensor
and diagnostic information, executes all math
calculations, performs MLI-related functions
based on user configuration, performs alarm
handling, and performs multi-tasking monitor
operations

Memory

1 megabyte non-volatile (program, configuration,
and data storage); 512 kilobytes static RAM

Data Storage

365 days (1 pressure and 2 float readings at a 15minute sample rate)

Sample Rates

Minutes: 1, 2, 5, 15, 30
Hours: 1, 2, 12, 24

Clock
Communications

Battery backed RTC module
Landline: Multitech Model MT5600SMI; FCC ID
6KDMD06AHS1; 19.2K baud with fallback to
9600 and 1200 as required for reliable
communication; regular 2-wire voice grade POTS
service line
Wireless: Enfora™ Dual band 850/1900 MHZ
GSM/GPRS; FCC ID MIVGSM0108; fixed
address via AT&T custom APN; refreshed every 4
hours via hard-attach
Serial/Direct Connect: RS-232

Comm Protocol

AccuYapp for configuration and diagnostics
Yapp for data collection and cryouts

Antenna

ADS whip or direct burial
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LED Diagnostic
Readings

Wireless signal strength
Battery voltage
Monitor IP address

Voltage
Regulator
Inputs/Outputs

13.5 VDC maximum input

ADS Pressure sensor/float switch input
Serial RS232 communication (external)
TTL serial communications (internal)

A/D Conversion

12 bit, 8 channel, 500KHz sample rate

Pressure Depth Sensor (ADS p/n 3704-001040)
The following table contains the specifications for the pressure
depth sensor.
Enclosure
Dimensions
Range

Solid machined PVC/stainless steel
5.25 inches long x 1.40 inches wide x 1.15 inches
high
0.0 to 5.0 psi: up to 11.5 feet
0.0 to 15.0 psi: up to 34.5 feet
0.0 to 30.0 psi: up to 69.0 feet

Accuracy

0.5% of full scale for these ranges:
0.1-5.0 psi: 0.25-11.5 feet
0.1-15.0 psi: 0.25-34.5 feet
0.75% of full scale for these ranges:
1.0-30.0 psi: 2.3-69.0 feet

Specifications

Resolution
Cable
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0.025% of full scale
Standard size: 40 feet long x 0.29 inches diameter
OD polyurethane jacket
Extension cables available up to 300 feet

Float Switch (ADS p/n 6000-0015/25/26/27-xx)
The following table contains the specifications for the float switch.
Type
Variation

Conery™ Control Duty 2900 Mercury Series –
Narrow-Angle, Internally-Weighted Switch
Single pole, double throw

Enclosure

Durable PP outer shell with solid polyurethane
foam interior

Dimensions

Float housing: 6 inches long by 4.25 inches in
diameter

Weighted Swtich
Operating
Temperature

Cast iron; internal at neck of floating housing
32° to 170° F (0° to 77° C)

Electrical Rating

10 AMPS at 120 VAC; 3 AMPS at 240 VAC

Actuation Point

1-inch (5 degrees) above / below horizontal

Cable

Conductor cord: Chlorinated polyethylene (CPE)
Electrical: 18 AWG, 3-conductor; type SJOOW300 Volt
Diameter: 0.31 inches
Available lengths: 20, 40, 60 feet
Note: Customer can extend the cable using 18
AWG, 3-conductor SJOOW cable as needed.
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Lightning Protection Module (ADS p/n 303313)
The following table contains the specifications for the lightning
protection module at the service location.
Housing

Gray PVC

Dimensions

4.13 inches high x 3.25 inches wide x 1.88 inches
deep

Polyswitch

600-volt 150-milliamps over-current protector

Varistor

240-volt over-voltage protector

Sidactor

280-volt over-voltage protector

Ground Wire

12 AWG black stranded

Service Wire

22 AWG 4-conductor gray unshielded

B-1

APPENDIX B

Part Numbers

This appendix includes tables for the part numbers of the most commonly
ordered and used FlowAlert system parts.
Monitors
6000-FAW

MONITOR, FLOWALERT, WIRELESS

6000-FAL

MONITOR, FLOWALERT, LANDLINE

Sensors, Float Switches, and Cables
3704-0010-40

SENSOR, PRESSURE, 0-5PSI, 40 ft.

3704-0015-40

SENSOR, PRESSURE, 0-15PSI, 40 ft.

3704-0016-40

SENSOR, PRESSURE, 0-30PSI, 40 ft.

6000-0013

CABLE, PRESSURE & FLOAT PIGTAIL

6000-0014

CABLE, PRESSURE ONLY PIGTAIL

6000-0021

CABLE, FLOATS ONLY, PIGTAIL

6000-0015-20/40/60

FLOAT, SINGLE, NO PRESSURE, SPDT, 20/40/60 ft.

6000-0025-20/40/60

FLOATS, DUAL, NO PRESSURE, SPDT, 20/40/60 ft.

6000-0026-20/40/60

FLOATS, DUAL & PRESS CONN, SPDT, 20/40/60 ft.

6000-0027-20/40/60

FLOATS, SINGLE & PRESS CONN, SPDT, 20/40/60 ft.

5000-0601

CABLE, RS232 WITH PHONE LINE
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Sensors, Float Switches, and Cables
5000-0664

CABLE, RS232 WITHOUT PHONE LINE

5000-0697

CABLE, PHONE

Communication and Antennas (for wireless communication)
3800-0128

ANTENNA, WHIP, 850/1900 MHz, SMA

3800-0133

ANTENNA, PEDESTAL, W/15-FOOT CABLE, SMA

3800-0162

KIT, ANTENNA, SLIM, SMA/TNC

3800-0163

KIT, ANTENNA, MINI-WING, SMA/TNC

507181

SIM CARD, WIRELESS GSM

507165

CABLE, ANTENNA, EXTENSION, 15-FOOT SMA

507168

CABLE, ANTENNA, EXTENSION, 50-FOOT SMA

507180

LIGHTNING PROTECTOR, ANTENNA, MALE-FEMALE, SMA
(for use only with the wireless magnetic whip antenna)

Monitor/Sensor Mounting Hardware (for wall mounting)
I40-0009/3

FLANGE HANDLE (BRACKET), 18- or 36-INCH (for mounting
monitor to manhole wall or rim)

106222A

HOOK, RUNG MOUNT (for mounting monitor to ladder rung)

700-100238-00

BRACKET, FIXED MOUNT (strap for mounting sensor to wall)

I25-0081 –
I25-0094

STANDARD SENSOR RINGS (sizes from 6 to 60 inches)

Monitor Replacement PCBs
6000-0001

PCBA, PROCESSOR, WIRELESS, FLOWALERT

6000-0001-01

PCBA, PROCESSOR, LANDLINE, FLOWALERT

3506-0078

PCBA, MODEM, LANDLINE, FLOWALERT

Monitor Replacement Battery Pack
6000-0004

BATTERY PACK, 7.5 V
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Index

1
1/2-band mount, 3-27

3
3/4-band mount, 3-24

A
activating the monitor, 5-24
activation logs, 5-47
alarms
editing the notification device,
5-18
antenna
inspection, 7-10
installing in a pedestal, 4-9
installing in the road, 4-3
installing on a roof or other
protected structure, 4-16
specifications, B-1

B
band
mounting sensor, 3-23
securing the sensor cable, 3-29
battery pack, 2-8
checking voltage, 7-4
minimum voltage requirements,
7-4
part number, B-1

replacement, 7-6
setting minimum voltage, 5-20
voltage, 2-8
voltage regulator, 2-6
battery voltage
reading, 7-4
board, 2-4
communication, 2-6
input device processing, 2-6
part number, B-1
processor, 2-5
specifications, A-3
voltage regulator, 2-6

C
cables
direct connection cable
connecting to the monitor and
field computer, 4-35
part numbers, B-1
running telephone cable between
monitor and service locations,
4-23
sensor
securing cable in the
pipe/manhole, 3-36
securing to the band, 3-29
securing to the ring, 3-17
telephone
laying cable between monitor
and service locations, 4-10
preparing cable, 4-26
wiring cable to monitor, 4-28
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wiring lightning protection to
network interface box, 4-32
wiring to lightning protection
module, 4-30
checking the battery voltage, 7-4
Class A Digital Device
FCC compliance
warning, 1-3
cleaning the float switch, 7-9
cleaning the sensor, 7-9
collecting data from the monitor,
5-37
communication, 2-6, 2-7
disclaimer, 1-2
GPRS, 2-7
installing a wireless antenna in a
pedestal, 4-9
installing a wireless antenna in the
road, 4-3
installing a wireless antenna on a
roof or other protected
structure, 4-16
land line, 2-6, 2-7, 4-22, 4-23
mounting lightning protection
module, 4-25
preparing telephone cable,
4-26
running the telephone cable,
4-23
wiring lightning protection
module to network interface
box, 4-32
wiring telephone cable to
lightning protection module,
4-30
wiring telephone cable to
monitor, 4-28
on-site, 4-35
remote, 4-2, 4-22
setting parameters, 5-20
SIM card installation, 4-17
troubleshooting, 7-16
using the direct connection cable,
4-35

viewing logs, 5-47
wireless, 2-6, 2-7, 4-2
configuring the power savings
parameters, 5-27
getting signal strength, 7-4
SIM card installation, 4-17
configuration, 5-2
creating a monitor location, 5-4
creating an installation table, 5-6
editing the float device, 5-13
editing the notification device,
5-18
editing the pressure device, 5-15
editing the RSSI device, 5-19
selecting devices, 5-11
setting communication parameters,
5-20
setting power saving parameters,
5-27
configuring the monitor, 5-2
creating a monitor location, 5-4
creating an installation table, 5-6
editing the float device, 5-13
editing the notification device,
5-18
editing the pressure device, 5-15
editing the RSSI device, 5-19
selecting devices, 5-11
confirmation, 7-3
connecting to the monitor on-site,
4-35
connectors, 2-7
cleaning and removing moisture,
3-42
monitor, 3-42

D
data collection, 5-37
logs, 5-47
depth
float switch, 2-10
pressure sensor, 2-9
troubleshooting, 7-20
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desiccant, 7-9
device
float switch
installation, 3-38
devices, 2-9
editing the float device in Profile,
5-13
editing the notification device in
Profile, 5-18
editing the pressure device in
Profile, 5-15
editing the RSSI device, 5-19
float switch, 2-10
pressure depth sensor, 2-9
running diagnostics, 5-32
selecting and editing in Profile,
5-11
diagnostics
obtaining codes from the monitor
confirmation, 7-4
pressure device, 5-32
digital signal processor, 2-5
direct connection cable, 4-35
dryer tube
replacement, 7-9
securing to the monitor, 3-45

E
editing the RSSI device, 5-19
events
editing the notification device in
Profile, 5-18

F
FCC Compliance, 1-2
interference, 1-4
part 15, 1-3
part 68, 1-3
firmware upgrade, 5-44
logs, 5-47

float switch, 2-10
cleaning, 7-9
connecting to the monitor, 3-42
description and operation, 2-10
editing the float device in Profile,
5-13
inspection, 7-9
installation, 3-38
part numbers, B-1
specifications, A-5
troubleshooting, 7-21

G
GPRS, 2-7, 4-2
ground rod installation, 4-25

I
input device processing, 2-6
inputs, 2-7
inspecting the float switch, 7-9
inspecting the monitor, 7-3
inspecting the sensor, 7-9
installation
connecting float switch to monitor,
3-42
connecting sensor to monitor,
3-42
float switch, 3-38
land line communication, 4-22
mounting lightning protection
module, 4-25
preparing telephone cable,
4-26
running cable between monitor
and service locations, 4-23
wiring lightning protection
module to network interface
box, 4-32
wiring telephone cable to
monitor, 4-28
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wiring telephone cable to
lightning protection module,
4-30
monitor, 6-1
mounting to a manhole ladder
rung, 6-12
mounting to the manhole rim,
6-6
mounting to the manhole wall,
6-3
mounting sensor to band, 3-23
mounting sensor to ring, 3-16
mounting sensor to strap, 3-31
mounting sensor to wall, 3-31
pressure depth sensor, 3-6, 3-24,
3-27
securing cable to band, 3-29
ring, 3-8, 3-18
securing sensor cable in manhole,
3-36
sensor
ring assembly, 3-8
special, 3-20
1/2-band mount, 3-27
3/4-band mount, 3-24
securing sensor cable to band,
3-29
standard, 3-6
telephone service, 4-22
mounting lightning protection
module, 4-25
preparing telephone cable,
4-26
running cable between monitor
and service locations, 4-23
wiring lightning protection
module to network interface
box, 4-32
wiring telephone cable to
lightning protection module,
4-30
wiring telephone cable to
monitor, 4-28

wireless antenna in a pedestal,
4-9
wireless antenna in the road, 4-3
wireless antenna on a roof or other
protected structure, 4-16
wireless communication, 4-2
SIM card, 4-17
installation table, 5-6
IP address
obtaining address from monitor,
7-4

L
landline communication, 2-6, 2-7
installation, 4-22
preparing telephone cable,
4-26
running cable between monitor
and service locations, 4-23
wiring lightning protection
module to network interface
box, 4-32
wiring telephone cable to
lightning protection module,
4-30
wiring telephone cable to
monitor, 4-28
mounting lightning protection
module, 4-25
troubleshooting, 7-16
launching the Profile software, 5-2
lightning protection module
connecting telephone cable, 4-30
connecting wires to network
interface box, 4-32
inspection, 7-10
installing the ground rod, 4-25
mounting, 4-25
specifications, A-6
logs, 5-47
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M
magnetic antenna installation, 4-16
maintenance
float device, 7-2
monitor, 7-2
pressure depth sensor, 7-2
manhole
conditions, 3-4
mounting monitor to a rung, 6-12
mounting monitor to the rim, 6-3
mounting the monitor to the wall,
6-6
securing sensor cable, 3-36
modem selection, 5-20
monitor
activation, 5-24
activation logs, 5-47
battery voltage, 2-8
board, 2-4
checking the battery voltage, 7-4
collecting data, 5-37
communication
GPRS, 2-7
land line, 4-22
landline, 2-7
wireless, 2-7, 4-2
configuration, 5-2
creating a monitor location, 5-4
creating an installation table,
5-6
editing the float device, 5-13
editing the notification device,
5-18
editing the pressure device,
5-15
editing the RSSI device, 5-19
selecting devices, 5-11
connecting float switch, 3-42
connecting sensor, 3-42
connectors, 2-7
description, 2-4
GPRS, 4-2
inspection, 7-2, 7-3

installation, 6-1
mounting to a manhole ladder
rung manhole wall, 6-12
mounting to the manhole rim,
6-6
mounting to the manhole wall,
6-3
installing landline communication,
4-22
mounting lightning protection
module, 4-25
preparing telephone cable,
4-26
running cable between monitor
and service locations, 4-23
wiring lightning protection
module to network interface
box, 4-32
wiring telephone cable to
lightning protection module,
4-30
wiring telephone cable to
monitor, 4-28
installing the SIM card, 4-17
installing wireless communication,
4-2
maintenance, 7-2
obtaining diagnostic codes, 7-4
opening enclosure, 7-6
part numbers, B-1
power
battery pack, 2-8
processor board, 2-5
replacing battery pack, 7-6
setting communication parameters,
5-20
setting power saving parameters,
5-27
SIM card installation, 4-17
specifications, A-1
troubleshooting, 7-13
upgrading the firmware, 5-44
viewing diagnostic logs, 5-47
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monitor configuration, 5-2
creating a monitor location, 5-4
creating an installation table, 5-6
editing the float device, 5-13
editing the notification device,
5-18
editing the pressure device, 5-15
editing the RSSI device, 5-19
selecting devices, 5-11

N
network interface box
connecting wires from lightning
protection module, 4-32
inspection, 7-10

O
on-site communication
using the direct connection cable,
4-35

P
part numbers
battery pack, B-1
board, B-1
cables, B-1
float switch, B-1
monitor, B-1
pressure depth sensor, B-1
pipe conditions, 3-4
pipe table, 5-6
port selection, 5-20
power, 2-8
battery pack replacement, 7-6
checking battery voltage, 7-4
pressure depth sensor, 2-9
description and operation, 2-9
editing the pressure device in
Profile, 5-15
inspection, 7-9

installation, 3-6
mounting to band, 3-23
mounting to ring, 3-16
part numbers, B-1
replacing the dryer tube, 7-9
ring assembly, 3-8
running diagnostics, 5-32
securing cable in manhole, 3-36
securing cable to the band, 3-29
securing cable to the ring, 3-17
securing the dryer tube to the
monitor, 3-45
special installation, 3-20
1/2-band mount, 3-27
3/4-band mount, 3-24
specifications, A-4
standard installation, 3-6
troubleshooting, 7-20
wall installation, 3-31
processor, 2-5
Profile
activating the monitor, 5-24
collecting data from the monitor,
5-37
configuring the power savings
parameters, 5-27
editing the RSSI device, 5-19
launching the software, 5-2
running diagnostics on device,
5-32
setting communication parameters,
5-20
upgrading the monitor firmware,
5-44
viewing logs, 5-47

R
remote communication
installing a SIM card, 4-17
setting up land line
communication, 4-22
setting up wireless
communication, 4-2
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replacing the battery pack, 7-6
ring
assembly, 3-8
installation, 3-18
mounting sensor, 3-16
securing the sensor cable, 3-17
RSSI device
editing, 5-19

S
scrubbing the sensor, 7-9
sensor
confirmation, 7-3
connecting to the monitor, 3-42
editing the pressure device, 5-15
inspection, 7-9
installation, 3-6
mounting sensor to band, 3-23
mounting sensor to ring, 3-16
pressure depth sensor, 3-24,
3-27
ring assembly, 3-8
securing sensor cable ein
manhole, 3-36
special, 3-20
standard, 3-6
wall, 3-31
mounting to the band, 3-23
mounting to the ring, 3-16
pressure depth, 2-9
running pressure depth
diagnostics, 5-32
scrubbing, 7-9
securing cable to the band, 3-29
securing cable to the ring, 3-17
sensors
pressure depth sensor
troubleshooting, 7-20
securing cable in the
pipe/manhole, 3-36
setting communication parameters,
5-20

signal strength, 5-20
editing the RSSI device, 5-19
SIM (Subscriber Identity Module),
4-2
SIM card installation, 4-17
site investigation, 3-4
special installation, 3-20
mounting sensor to the band,
3-23
specifications, A-1
board, A-3
float switch, A-5
lightning protection module, A-6
monitor, A-1
pressure depth sensor, A-4
wireless antennas, B-1
standard installation
mounting sensor to ring, 3-16
mounting sensor to the ring, 3-16
ring, 3-18
ring assembly, 3-8
static IP address, 4-2
Subscriber Identity Module (SIM),
4-2

T
TCP/IP, 5-20
getting address from monitor, 7-4
telephone cable
preparing for connection, 4-26
running between monitor and
service locations, 4-10, 4-23
wiring lightning protection
module to network interface
box, 4-32
wiring to lightning protection
module, 4-30
wiring to monitor, 4-28
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telephone service, 4-22
installation, 4-22
installing the ground rod, 4-25
laying telephone cable between
the monitor and service
locations, 4-10
mounting lightning protection
module, 4-25
preparing the telephone cable,
4-26
running cable between the
monitor and service
locations, 4-23
wiring lightning protection
module to network interface
box, 4-32
wiring telephone cable to
lightning protection module,
4-30
wiring telephone cable to
monitor, 4-28
mounting lightning protection
module, 4-25
troubleshooting, 7-12
communications, 7-16
float switch, 7-21
monitor, 7-13
pressure depth sensor, 7-20

V
voltage, 2-8
voltage regulator, 2-6

W
warranty, 1-6
whip antenna, 4-16
wireless antenna
specifications, B-1
wireless communication, 2-6, 2-7
configuring the power savings
parameters, 5-27
editing the RSSI device, 5-19
installation, 4-2
SIM card, 4-17
installing an antenna in a pedestal,
4-9
installing an antenna in the road,
4-3
installing an antenna on a roof or
other protected structure, 4-16
obtaining signal strength, 7-4
troubleshooting, 7-16

